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Abstract
Johnathan Morris
ENGINEERING A HIGH-THROUGHPUT SCREENING PLATFORM FOR
ASSESSING DEVELOPMENTAL NEUROTOXICITY THROUGHOUT HEADREGENERATION IN SCHMIDTEA MEDITERRANEA
2020-2021
Mary M. Staehle, Ph.D.
Doctor of Philosophy
The increase in commercially used chemicals that are inadequately evaluated for
safety and risk to development has created a reticent threat to human health. Addressing
these deficiencies is compounded by limited methodologies to determine the etiology of
exposure-related developmental neurotoxicity (DNT). Current means of assessing DNT
are largely retrospective and limited by the expensive, time-consuming, and labor-intensive
use of laboratory animal models, thereby motivating a global research effort to produce
alternative chemical screening assays. In this work, we have developed a novel highthroughput platform that serves as a new tool to evaluate the effects of exogenous chemical
exposure on developmental processes in the non-vertebrate animal model, Schmidtea
mediterranea (Smed). We demonstrate that light avoidance in Smed is a robust behavior
that can be assayed throughout head regeneration and is temporally correlated to the
anatomical development of central nervous system structure. Thus, reacquisition of this
behavior serves as a surrogate measure of neurodevelopment that can be utilized to
characterize exposure-related effects in DNT. Our high-throughput screening platform
enables a more sensitive classification of these responses and assesses both endpoint and
temporal effects of chemical exposure in DNT, which paves the way for more exhaustive
and predictive chemical assessment to minimize the impact on human health.
v
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Chapter 1
Introduction
There are more than 80,000 chemicals used commercially in the United States, and
approximately 700 new chemicals are introduced each year, yet due to limitations in time,
cost, and available personnel, less than 20% of those chemicals are thoroughly evaluated
for safety and risk to human health (Hartung et al., 2009). In recent years, the increasing
rate of chemical production has made toxicity screening a daunting task, further hindered
by current, albeit archaic, means of evaluation. This shortcoming in chemical risk
assessment translates to an alarming lack of knowledge on the effects of under-evaluated
chemicals on development. Development is characterized as a period of progressive change
in cell size, shape, and function across multiple organismal levels that translates genetic
potential, or genotype, to mature functioning systems, phenotype. Developing brains are
continually subjected to modifications and connections influenced by the environment
around them, as chemicals are continuously pumped into the environment through daily
processing or presented directly to our youth in consumer goods (Wallace et al., 2012;
CDC, 2019). Consequently, youth are particularly vulnerable to the effects of chemical
exposure. Exposure to exogenous chemicals during the fragile time of development can
increase the risk of developmental neurotoxicity (DNT). Neurodevelopmental disorders
(NDDs) affect 10-15% of all births, with 3% of NDDs being the direct result of
environmental exposure to known toxins (Gradjean and Landrigan et al., 2006, 2014).
Many more NDDs could be the results of environmental exposure to unknown toxins, with
less than 2% of chemicals being assessed for DNT before commercialization (Smirnova et
al., 2014). DNT can lead to more serious conditions, such as death, malformation, growth
1

retardation, and functional deficits (Wilson et al., 1973). Unfortunately, the latter of those
indications have proven immensely difficult to recognize, record, and relate to chemical
exposure – in part creating a silent pandemic attributed to exposure to under-evaluated
chemicals.
Current methods for assessing chemical DNT are expensive, labor-intensive, timeconsuming, and predominantly retrospective in humans and higher-level organisms.
Models that stray away from the use of traditional laboratory animals will have an
advantage in the future of toxicity screening due to their aptness for high-throughput
applications (Bailey et al., 2014). Ergo, interest has turned to chemical screening platforms
that contribute to the reduction, refinement, and replacement of vertebrates in toxicity
testing, to better align with government initiatives like those outlined in the 2019 National
Toxicology Program Annual Report. These platforms are already producing valuable
information on the toxicity of known and potential neurotoxins, such as alcohol, pesticides,
flame retardants, and xenoestrogens (Lowe et al., 2015; Hagstrom et al., 2015, 2016; Hunt
et al., 2017; Tierney et al., 2011; Zhang et al., 2018, 2019). Introducing engineering
principles and design of experiment techniques will exponentially increase the quantity and
quality of chemical toxicity data obtained from these alternative animal models.
High-throughput screening uses automated assays to rapidly test large numbers of
chemicals in parallel for biological activity on the model organism, cellular, pathway, or
molecular level (Attene-Ramos et al., 2014; Macarron et al., 2011). Until recently, highthroughput chemical evaluation has primarily utilized in vitro assays for evaluation, while
in vivo testing methods have been subjected to low- and medium-throughput testing,
performing single or few tests in parallel, due to experimental limitations inherent in
2

traditional animal models. The successes of high-throughput adaptations of alternative
animal models, such as C. elegans and zebrafish, indicate the valuable role of other
relatively underutilized in vivo screening methods in chemical risk evaluation (Boyd et al.,
2010; George et al., 2011; Partridge et al., 2018; Zhang et al., 2017).
This dissertation will present valuable evidence of the utility of Schmidtea
mediterranea (Smed), a species of planarian flatworms, in the high-throughput screening
of exogenous chemicals for neurodevelopmental toxicity. Chapter 2 will provide necessary
background information from the literature pertaining to the following studies. Chapter 3
details common methodology for subsequent experiments. Chapter 4 will characterize the
effects of exposure to known neurotoxins, bisphenol A (BPA) and its analogs, in
developing planaria. Chapter 5 will describe detailed specifications for the design,
construction, and validation of a high-throughput platform for assessing developmental
neurotoxicity in planaria. Chapter 6 will demonstrate the advantages of high-throughput
screening in the assessment of exposure-induced chemical developmental neurotoxicity in
planaria. Chapter 7 will serve as a high-throughput correlation analysis of chemical
structure and neurotoxicity phenotype induced by exposure to common flame retardants in
developing planarian. Finally, Chapter 8 will draw conclusions on the work presented and
offer commentary on henceforth endeavors.
This collection of work presents an automated high-throughput platform for
chemical risk evaluation for neurodevelopmental toxicity that is complementary to
currently existing screening methods. It features the utility of planarian flatworms as a
model for neurodevelopment, compared to traditional laboratory animals that are typically
expensive, labor-intensive, and ethically questionable. The biological attributes of
3

planarian flatworms, namely their affinity for regeneration and access to multiple
behavioral and morphological readouts, make them an ideal alternative animal model for
rapid in vivo chemical testing. In alignment with current trends towards automated and
expansive chemical safety and risk assessment, this dissertation contributes evidence of the
significance of high-throughput techniques utilizing planarian flatworms as a model
organism in the field of toxicology.

4

Chapter 2
Background
2.1 Planaria as an Alternative Animal Model for Developmental Neurotoxicity
Planarian regeneration has marveled scientists since it was first documented in 1766,
when a famous German naturalist by the name of Peter Simon Pallas, observed that
freshwater planaria flatworms (Platyhelminthes, Tricladida) display a biological feature
that allows them to regenerate whole animals from seemingly miniscule fragments of their
bodies (Pallas, 1766). In 1814, John Graham Dalyell, another European naturalist,
discovered that these “masters of regeneration” could live indefinitely when kept under
suitable conditions (Dalyell, 1814). In this text, Dalyell coined the phrase “Immortal under
the edge of a knife,” when describing planaria’s longevity, which was nearincomprehensible at the time. These findings fueled the curiosity of which biological
processes were involved and regulate regeneration in planaria.
Almost a century after the work of Pallas and Dalyell, understanding of planarian
anatomy evolved to recognize that the anterior region, containing the auricles and eye
spots, controls the process of cell density regulation in regions posterior to it (Child, 1911).
Planarian body integrity is controlled by an abundant population of pluripotent stem cells,
termed neoblasts, that migrate and proliferate into damaged or missing cell types to
maintain homeostatic structure and patterning (Baguna, 1981). Some species of planaria
reproduce asexually from budding, with no progressive senescence observed among
generations (Child, 1914). It was noted that planaria will decrease in size due to starvation,
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while the anterior region decreases in size much less rapidly than other parts of their body
(Child, 1911).
The anterior head region contains sensory cephalic lobes or auricles that function as
smell and touch organs, and rudimentary “eyes” consisting of black pigment spots and
unpigmented sensory areas resembling a common small plastic craft supply, a structure
most kindergarteners would describe as “googly eyes” (Figure 2.1). In 1920, the negative
phototactic behavior of planaria was described, and the photoreceptors, or “googly eyes,”
were shown to be involved in the perception of light stimuli (Taliaferro, 1920). This study
observed that decapitated posterior fragments of planaria, with photoreceptor anatomy
removed, fail to orient themselves in the presence of light stimuli, and intact normal
specimens swim away from directed light with precision.
The invention of the electron microscope in 1931 led to a breakthrough in
understanding of planaria anatomy. Through this powerful investigation tool, researchers
were able to report on the complexity of the planarian central nervous system (CNS). The
planarian CNS consists of an anterior brain or cephalic (pertaining to the head) ganglia
(bundle of nerve cells), and a pair of ventral nerve cords that run along the length of the
flatworm (Bullock and Horridge, 1965). The planarian brain is organized as a central
neuropil surrounded by an outer layer of neuronal cell bodies and contains a heterogeneity
of neuron types including multipolar, bipolar, unipolar, and pseudo polar neurons described
by shape and afferent, motor, and inter neurons described by function (Morita et al., 1966;
Lentz et al., 1968). This complex structure extends caudally on the ventral side of their
bodies to form nerve cords containing small ganglia with lateral and transverse
commissural fibers stemming from the ventral nerve cords (Baguna 1978). The complexity
6

of planarian’s brain structure exemplifies one of the simplest extant specimens of evolution
of the mammalian-like brain, demonstrated by bilateral symmetry, centralized clusters of
nerve cell bodies, and spinal cord-like structures, in the two ventral nerve cords. This,
combined with relatively simple anatomy, the ability to impose development at will, and
the access to multiple observable behavioral readouts, made planaria an attractive model
for studying the effects of chemical exposure on brain development (Best and Morita
1982).

7

Figure 2.1
Schmidtea mediterranea Planarian Flatworms with Dorsal and Ventral Views

#

@

*

Note. Eye spots denoted with *, pharynx denoted with #, pharyngeal opening and mouth
denoted with @. Scalebar is 3 mm.

It is because of these unique characteristics that planaria hold such utility in modern
neurotoxicology. As interest has increased in planaria as a model for neurodevelopment,
the understanding of the biological processes that enable these feats has evolved. Through
the use of immunohistochemistry, the processes of planarian neurodevelopment have been
described with the development of brain and visual systems characterized into three distinct
stages; quantification of the immunostaining images presented in chapters 4, 5, and 6 are
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based on these studies (Cebria et al., 2002; Inoue et al., 2004). The first stage of planarian
brain development occurs between 1- and 3-days post amputation and is defined by the
appearance of the new brain primordium within the regenerating blastema, which
originates from the proliferation of neoblasts in the stump region and the coordinated
migration of surrounding neoblasts within the blastema. The second stage occurs between
4- and 5-days post amputation and is defined by the brain primordium differentiating into
a small brain with bilateral symmetry, connected in the most anterior part, with few lateral
branches projecting to the new head periphery. Connections between the new brain
regenerate and the ventral nerve cords are re-established at this stage. In the final stage,
occurring between 6- and 9-days post amputation, the original CNS patterning is restored
on a structural level, with new spongy brain and ventral nerve cord connections with robust
transverse commissural fibers (Cebria et al., 2002). Regeneration of visual systems in
planaria follow closely with the development of new CNS structure post amputation. By
two days of regeneration, two laterally restricted visual cell-clusters in the dorsal side of
the anterior blastema form. The appearance of contralateral axonal projections oriented
towards the bilateral midline appear by three days of regeneration. After four days of
regeneration, posteriorly directed axonal projections from the photoreceptor neurons
connect with brain structure. At this time, it is expected to observe distinguishable
photophobic responses to light stimuli (Inoue et al., 2004). Our work presented in chapters
4, 5, 6, and 7 reflect these stages of planarian neurodevelopment, which provided guidance
in the methodology of our experiments.
Planaria locomotive behavior has been classified in response to exposure to a
variety of chemicals dissolved in their aqueous environment using the planaria locomotive
9

velocity (pLMV) metric described in Raffa et al., 2001. The effects of exposure to alcohol,
caffeine, nicotine, cocaine, and amphetamine exposure and withdrawal, industrial
endocrine-disrupting chemicals, pharmaceutically active chemicals, flame retardants, and
a library of known and suspected neurotoxic substances on planarian locomotion have been
documented (Lowe et al., 2015; Rawls et al., 2001, 2006, 2008, 2011; Pagen et al., 2006;
Li et al., 2013a, 2013b, 2014; Hagstrom et al., 2016; Zhang et al., 2018, 2019). Beyond
exposure-induced toxic phenotype investigations, mechanistic studies that aid in the
understanding of the impact of neurotoxins on the molecular level are easily accessible due
to their stable, diploid genome being fully sequenced, available, and searchable online
(smedgd.neruo.utah.edu) (Robb et al., 2007, 2015; Alvarado et al., 2002; Mineta et al.,
2003). The value of these analytical tools in neurodevelopmental toxicity studies is further
amplified due to the ability to evaluate and directly compare developing head-regenerating
and intact non-regenerating worms in parallel.
One of the most predominant behaviors of planaria is negative phototaxis. Planaria
sense light through two eye spots, called ocelli, located on the anterior-dorsal side of their
bodies. These ocelli consist of two types of cells, pigment cells and photoreceptor neurons.
Pigment cells function to absorb incoming light while photoreceptor neurons then
reinterpret the presence of light stimuli into defined cellular functions that result in
cognitive processes and distinct behaviors (Taliaferro 1920; Carpenter et al., 1974; Inoue
et al., 2004). Planarian photoreceptors are bipolar neurons with dendrites located inside
two optic cups, located on the right and left anterior side of the animal, and axons projecting
posteriorly onto the cephalic ganglia forming the optic chiasma, where photosensory input
is translated to visual information (Carpenter, Morita, and Best, 1974; Agata et al., 1998;
10

Sakai et al., 2000; Okamoto et al., 2005). The dendrites in the optic cup form a rhabdomeric
structure where opsin accumulates; opsins are a highly conserved class of G-protein
coupled receptors that covalently bond to a chromophore forming the light-sensitive
receptor protein, rhodopsin (Orii et al., 1998; Asano et al., 1998; Wald et al., 1968).
Transcriptome analyses have reported the conservation of rhodopsin signaling pathways in
planaria and suggest that the phototransduction cascade is conserved as well (Lapan and
Reddien, 2012). It is believed that varying levels of rhodopsin activity between
photoreceptor neurons located in the left and right optic cups facilitate the spatial
recognition of light intensity gradients; however, the underlying processes of planarian
photophobic behavior remain elusive. Light avoidance in planaria is an inherent behavior
that requires cognitive function to complete; the flatworms must detect light through the
connection of visual systems to the cephalic ganglia, coordinate movement to the direction
of reduced light, and continually reevaluate their position relative to the light source.
Assessments of related cognitive processes have been documented using the planarian light
avoidance assay, in which planaria are positioned in an environment containing defined
light and dark areas and their placement preference and locomotive activity are scored
(Inuoe et al., 2004; Lowe et al., 2015). Chapter 4 compares results from a planarian light
avoidance behavioral metric, which are quick and inexpensive to perform, with
immunostaining images of planarian CNS following exposure to exogenous chemicals.
Planarian light avoidance is a useful readout that gauges the cognitive ability of developing
and adult planaria and has the potential to be optimized for rapid and expansive evaluations.
Chapters 4, 5, 6, and 7 are all based on principles of planarian light avoidance and attest to
the behavior’s usefulness in chemical screening for developmental neurotoxicity.
11

Further investigations are required to better understand the functionalities and
caveats to planarian photosensing and the planarian light avoidance assay for
developmental neurotoxicity, some of which are addressed in the construction of a highthroughput platform for the planarian light avoidance assay described in chapter 5. The
planarian model for neurodevelopment is centered around this powerful behavioral metric
and provides a promising tool to assess relative cognitive ability during neurodevelopment
in response to chemical exposure. Therefore, it is imperative that the robustness and
accuracy of planarian light avoidance behavior be investigated further. Chapters 4, 5, 6,
and 7 aim to evaluate light avoidance as a suitable metric for high-throughput applications
and standardize practices for these assays.
2.2 Developmental Neurotoxicity of Bisphenol A and other Bisphenols
Bisphenol A (BPA, 2,2-bis(4-hydroxyphenol)propane), was first synthesized in
1891 by Aleksandr Dianin, and initial accounts of its estrogenic activity were recorded in
1936 (Dobbs, 1936). In the 1950s, it was discovered that BPA could be polymerized to
make polycarbonate plastics that are lightweight, transparent, and colorable, with a
favorable resistance to impact and heat (Eladak et al., 2015). These advantageous material
properties have popularized the commonly used monomer to one of the highest volume
chemicals produced worldwide, with an estimated 6 billion pounds produced each year
(Vandenberg et al., 2013, Xaio et al., 2020). BPA is used in the manufacturing of consumer
goods including polycarbonate plastics, epoxy resins used in the linings of food and
beverage cans, building materials, medical equipment, and thermal receipt paper, and it has
been shown to leach out of these products under some conditions (Kang et al., 2002;
Cooper et al., 2011). Therefore, it is hypothesized that most Americans are in constant
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exposure to BPA at low levels. The leading routes of exposure are dermal absorption and
the consumption of food and beverage products contaminated by their packaging (Kang et
al., 2006). BPA has been measured in men, women, children, infants, and fetuses in serum,
urine, umbilical cord and fetal serums, breast milk, and placental tissue (Vandenberg et al.,
2007).
BPA is a known endocrine disruptor and has been shown to lead to
neurodevelopmental deficits, even in low doses of exposure, by acting through estrogen
receptor competition (Della Seta et al., 2005; Kubo et al., 2004; Pang et al., 2019; Rochester
et al., 2013; Vandenberg et al., 2007). In its unconjugated form, BPA can act as a weak
xenoestrogen and disrupt endocrine activity due to some structural homology (Figure 2.2).
Bioactive BPA binds both ESR1 and ESR2 nuclear receptors with 0.1 and 0.01% the
affinity of its endogenous agonist, estradiol (17β-estradiol), and induces ESR1 and ESR2mediated gene expression (Wetherill et al., 2007). BPA can also activate gene expression
and production of ESR1 itself and activate rapid signaling via non-nuclear receptors with
equivalent potency as estradiol; this effect seems to be conserved across different species
(Vom Saal et al., 2007; Bhandari et al., 2015). The effects of BPA exposure are not limited
to estrogenic pathways, and there is evidence that non-estrogenic activity of BPA can lead
to neurodevelopmental abnormalities in some species (Pastva et al., 2001; Oka et al., 2003;
Bhandari et al., 2015; Wu et al., 2021). These non-estrogenic effects are revisited in
Chapter 4.
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Figure 2.2
Chemical Structure of Bisphenol A (BPA), a Xenoestrogen (Left), and Endogenous
Estrogen (Right)

In adults, approximately 80% of BPA is metabolized by-way-of the uridine 5’diphospho-glucuronosyltransferase (UGT) system to BPA-glucuronide, and a small
portion of BPA is converted to BPA-sulfate by cytosolic sulfotransferase; neither
conjugated form binds to estrogen receptors (Taylor et al., 2011; Volkel et al., 2002). As a
result, bioactive BPA has a short residence time in the adult human body; however,
expression and activity of UGT enzymes is reduced in human fetuses, and BPA and BPAsulfate have been shown to be present in much higher concentrations than BPAglucuronide in mid-gestation umbilical cord serum (Gerona et al., 2013; Hengstler et al.,
2011). This raises a concern that accumulated bioactive BPA levels in developing fetuses
could be considerably higher than those measured in adults, thus precipitating the need for
studies to define and characterize the consequences of prenatal BPA exposure. Several
groups have investigated the impact of prenatal BPA exposure on neurodevelopmental
outcomes in children (Braun et al., 2011, 2009; Perrera et al., 2012; Yolton et al., 2011;
Miodovnik et al., 2011; Evans et al., 2014). Although there appears to be a wide
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distribution of both the nature of effects across sexes and the degree of impairment, the
consensus of these studies strongly suggests that prenatal exposure to BPA is associated
with neurobehavioral disorders in children (Rochester, 2013). Due to the ethical
considerations involved in studying prenatal exposure in humans, these types of studies
can only reveal correlations, not causation. Consequently, investigators have turned to in
vitro assays and animal models to characterize the effects of prenatal exposure to BPA,
including studies in rodents (Angle et al., 2013; Mathisen et al., 2013), birds (Mathisen et
al., 2013), and aquatic life (Bhandaria et al., 2015; de Kermoysan et al., 2013; Hulak et al.,
2013; Saili et al., 2012; Wang et al., 2013). These studies bring forth clear evidence that
prenatal BPA exposure has the capacity to alter developmental processes; Chapters 4 and
6 explore the exposure-induced effects of BPA in a developing model organism, Smed.
Importantly, there is a large spectrum of effects that have been shown to depend on the
timing, duration, and dosage of exposure, and there is the potential for synergistic
combinatorial effects with other environmental toxins. An example being genistein, a
flavonoid found in a number of plants, whose co-exposure along with BPA exacerbates
neurotoxic phenotypes of concentrations that otherwise produce no adverse effect (Kong
et al., 2013). In order to unravel the compound effects and complexity of prenatal exposure
to BPA, there is a need for high-throughput testing of various exposure paradigms. Chapter
5 describes the development and validation of such a high-throughput platform to aid in
the characterization of the developmental effects of BPA exposure.
One response to the potential detrimental effects of BPA is to eliminate the use of
BPA in consumer products, implemented by the implementation of BPA substitutes that
maintain or improve material properties and reduce toxicity. The use of BPA-containing
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polycarbonates and epoxies has been “abandoned” by manufacturers of baby bottles, sippy
cups, infant formula can linings, and most disposable water bottles (FDA, 2012, 2013),
largely under precautionary principles. Notwithstanding, BPA provides desirable material
properties to resins and plastics, and so in some cases, it has been replaced with chemicals
of unknown toxicity, including bisphenol S (BPS, bis(4-hydroxyphenyl)sulphone) and
bisphenol F (BPF, bis(4-hydroxyphenyl)methane) (Choi et al., 2017). Unfortunately,
recent studies have shown that these substitutes also have xenoestrogenic activity and
hormone-mimicking properties (Eladek et al., 2015; Grignard et al., 2012; Molina-Molina
et al., 2013; Kuruto-Niwa et al., 2005). Chapters 5 and 6 evaluate the developmental
neurotoxicity of a new potential alternative bisphenol, bisguaiacol (BG), previously
reported in Hernandez et al., 2016, and compare exposure-induced toxicity across a subset
of bisphenols in developing planarian flatworms.
Preliminary searches of the planarian genome identified homologues for human
estrogen receptors and sulfotransferases, suggesting that planaria possess similar
mechanisms for metabolizing and/or conjugating BPA (Robb et al., 20015). Of particular
interest, a 2013 study of the effects of six industrial endocrine-disrupting chemicals on a
popular species of planaria, Dugesia japonica, showed that BPA was the most toxic with
a 48-hour LC50 of 8.3 mg/L (Li et al., 2013a). Other studies reported effects of estradiol
and BPA on the formation and function of planarian reproduction organs (Miyashita et al.,
2011; Sugiyama et al., 2008). However, there is a pressing need for studies on
neuroregeneration in planaria exposed to these chemicals. Planaria have a large population
of pluripotent stem cells that contribute to their regeneration potential; therefore, it can be
surmised that exposure during head regeneration may affect neurodevelopment. The effects
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of exposure to some exogenous chemicals, including BPA, during head regeneration in
planarian flatworms is described in chapters 4, 5, 6, and 7.
2.3 Developmental Neurotoxicity of Phased-Out and In-Use Flame Retardants
Similar to BPA, flame retardants (FRs) have been added to a spanning array of products
due to their favorable properties when supplemented into consumer goods.
Organophosphate and brominated flame retardants (OPFR and BFR, respectively) can be
found in electronic equipment, plastics, textiles, rubbers, and building materials
(Kemmlein et al., 2003). Alarmingly, most FRs are not chemically bound to products, but
rather mixed into polymer, thus increasing substance emission via abrasion and leaching
(van der Veen and de Boer, 2012). While the heavily-used brominated FRs are being
phased-out due to concerns over their bioaccumulation and potential toxicity,
organophosphate FR occurrence in 2015 was estimated to be 680,000 tons in the US, with
production rates projected to increase annually (EPA, 2009; Wei et al., 2015). The common
household is in near-constant contact with FRs. Traces of BFRs and OPFRs have been
found in virtually all indoor environments around the world including cars, classrooms,
living rooms, and offices (Brommer et al., 2015, Stapleton et al., 2009; He et al., 2018,
Percy et al., 2020). BFRs and OPFRs have also been found in food, air, dust, soil,
wastewater, birds, marine species, and in human tissues, serum, blood, and breast milk
(Schecter et al., 2008; He et al., 2015; Kim et al., 2014; Shoeib et al., 2014; Cequier et al
2015; Obrien et al., 2015; Li et al., 2017).
These molecules are easily absorbed by the body through inhalation, dust ingestion,
and dermal contact, leading to concerning bioaccumulation rates of these potentially
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harmful chemicals (He et al., 2015, Brommer et al., 2015, Percy et al., 2020). Due to the
nature of the routes of exposure to FRs, children are the most at-risk to exposure-induced
toxicity of BFRs and OPFRs, and exposure to harmful chemicals during necessary
processes of development increases the risks of developmental neurotoxicity (DNT) related
to FR exposure (Branchi et al., 2003; Birnbaum and Staskal, 2004; McDonald, 2005;
Herbstman et al., 2010). Importantly, children are susceptible to prolonged exposure to
FRs starting even before birth lasting into childhood. BFRs have been reported to cross the
placenta, with similar concentrations, ranging from 14 – 580 ng/g lipid of BFRs found in
maternal and fetal blood (Mazdai et al., 2003; Bradman et al., 2007). Levels of BFRs found
in breast milk have been increasing in the last decade and are already at alarming levels
(Costa and Giordano, 2007). It has been estimated that breastfed infants are exposed to
approximately 306 ng/kg/day of BFRs, compared to around 1 ng/kg/day for the average
adult (Schecter et al., 2006). Toddlers are also vulnerable to increased FR exposure due to
the high levels of FRs found in dust; it is expected that toddlers ingest approximately 100
mg/day of household dust, compared to 50 mg/day for adults; these differences in body
burden are made even more prominent when compounded with differences in body weight
(USEPA, 1997; Wilford et al., 2005; Costa and Giordano, 2007). An important determinant
of chemical toxicity and bioaccumulation of xenobiotics is their biotransformation and
metabolite production; unfortunately, there is little research on the metabolism of most FRs
in the human body and this is an area in need of further research (Van den Eede et al., 2013;
Roberts et al., 2012).
The ubiquity of FRs increases the urgency and need for in-depth toxicological
assessments of OPFRs. Animal studies have shown that both pre- and postnatal exposures
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to BFRs may be related to long-lasting alterations to locomotive and cognitive behavior
(Branchi et al., 2003; Brinbaum and Staskal, 2004; McDonald, 2005; Viberg et al., 2006),
and the unease surrounding their OPFR replacements is furthered by records of DNT linked
to similar classes of organophosphate chemicals, such as organophosphorus pesticides
(Eaton et al., 2008; Gonzalez-Alzaga et al., 2014; Ricceri et al., 2006). In response to the
clear lack of understanding on the effects of OPFRs on human health, scientists have turned
to mass screening using a battery of in vitro and alternative animal assays to investigate
similar toxicological activity between OPFRs and BFRs (Behl et al., 2015). These efforts
have found that exposure to some OPFRs causes comparable toxic effects to what is seen
with BFRs in nematodes and zebrafish when looking at developmental endpoints (Jarema
et al., 2015; Sun et al., 2016; Glazer et al., 2018). Assessing the impact of exposure to these
chemicals throughout development offers additional insight on the severity of OPFR
exposure related DNT. Chapter 7 investigates the potential neurotoxicity of OPFRs
compared to their phased-out predecessors BFRs using a comprehensive and exhaustive
behavioral readout to describe endpoint and temporal effects in DNT.
2.4 High-Throughput Screening, Predictive Toxicology, and Informed Chemical
Design
Thousands of chemicals are in global commercial use, but only a small fraction of
these chemicals have been sufficiently evaluated for potential toxic effects (Hartung,
2009). Current methods of chemical risk evaluation cannot keep up with increasing rates
of chemical production. It was reported in 2008 that thorough assessment for
developmental toxicity of one chemical requires the use of approximately 3,200 vertebrate
animals and costs about $500,000-700,000 USD (Scialli, 2008). With clear monetary and
19

ethical incentives to address this problem, a collaboration between the National Institute of
Environmental Health Sciences (NIEHS), the U.S. Food and Drug Administration (FDA),
and various other government agencies, entitled the Toxicology in the 21st Century
(Tox21), has called for the development of new ways to rapidly test substances for adverse
effects on human health (Thomas et al., 2018). The strategic vision of the Tox21 initiative
is to create an expansive portfolio of alternative testing systems to be used cooperatively
to predict human toxicity while reducing and refining the incorporation of traditional
laboratory animals, testing time, cost, and labor efforts.
In vitro assays were the first to answer this call, with the intent of recognizing and
assigning priority among substances requiring additional, more conventional toxicity
testing. The Environmental Protection Agency’s (EPA) Toxcast project has facilitated the
assessment of thousands of chemicals for bioactivity across multiple cellular signaling
pathways and biochemical targets (Dix et al., 2007; Kavlock et al., 2009; Houck et al.,
2009; Judson et al., 2010; Knudsen et al., 2010; Martin et al., 2010; Reif et al., 2010;
Rotroff et al., 2010). These studies probed various facets of development describing the
effects of chemical exposure on neural stem cell proliferation and differentiation,
migration, neurite outgrowth, synaptogenesis, network formation, myelination, and
apoptosis (Harrill et al., 2010, Harrill et al., 2011b; Culbreth et al., 2012; Krug et al., 2013;
Zimmer et al., 2014; Frank et al., 2017; Schmuck et al., 2017). When combined with
bioinformatics analyses, in vitro assays provide a powerful tool for rapid chemical testing;
however, they are limited to predicting effects on neuronal function and therefore omit the
ability to describe dynamic changes to developmental processes independent of systemic
toxicity (Fritsche et al., 2018; Smirnova et al., 2014; Tohyama, 2016). These challenges to
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relate cell phenotypes to human relevancy outweigh their amenability to high-throughput
methods in most applications, as they inherently lack cell-cell interactions and xenobiotic
metabolism that heavily influence chemical toxicity. Non-vertebrate alternative animal
models that possess the complexity needed to describe the functional perturbations related
to neurodevelopmental toxicity present an opportunity to expand on in vitro studies while
preserving their high-throughput methodology.
The rising need for new approach methodologies (NAMs) for more timely and
responsive chemical risk assessment has produced several medium- and high-throughput
in vivo models. Zebrafish are a popular in vivo model organism used to study
developmental processes beyond the scope of in vitro assays due to their ease of culture,
small size, and complex organ systems. Documented high levels of drug activity
conservation between humans and zebrafish has led to the creation of multiple disease
models utilizing their high fecundity, short development period, and easy gene
manipulation (Lieschke et al., 2007; Zon et al., 2005; Rubinstein et al., 2003; McGrath et
al., 2008; Shin et al., 2002). Behavioral metrics, such as swimming conditioned preferred
placement, and photomotor responses, have been adapted to high-throughput methods for
describing the effects of neuroactive chemicals (Burgess and Granato et al., 2007; Burgess
et al., 2010; Jain et al., 2011; Cachat et al., 2011; Green et al., 2012; Grossman et al., 2011;
Stewart et al., 2011; Fernandes et al., 2012; Kyzar et al., 2013; Stewart and Kalueff, 2014;
Kaleuff et al., 2016; Kokel et al., 2013). High-throughput screening assays using zebrafish
have been used to study a variety of neurodevelopmental disorders including attentiondeficit/hyperactive disorder (ADHD), autism spectrum disorder (ASD), and epilepsy (State
and Sestan, 2012; Lange et al., 2012a, b). Interestingly, zebrafish possess optically
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transparent skin that facilitate high-throughput imaging assays unique to this anatomical
feature (Pardo-Martin et al., 2010). It is worth noting, that the zebrafish neurodevelopment
model is unique in its access to both in vitro and in vivo terminology due to the invertebrate
classification of zebrafish larvae (Le Fol et al., 2017; Steele et al., 2011; Juan-Garcia et al.,
2020).
Planarian flatworms share many of the advantageous characteristics of zebrafish,
including their ability to be placed in 96-well plates and absorb water-soluble chemicals
dermally, greatly facilitating high-throughput assays. Planaria offer a complementary
chemical toxicity assessment tool that fills in limitations of the zebrafish model,
specifically contributing to the evaluation of regenerating animals coinciding with the
entire developmental process. No animal model will be able to fully recapitulate the
symptoms of human neurodevelopmental disorders; however, these non-mammalian
models conserve the key biological pathways underlying simple behaviors, which are
straightforwardly analyzable and likely to hold translational relevance in humans. Data
obtained for these organisms can be further utilized in the creation of computer driven
predictive models for chemical toxicity, where their empirical data is extrapolated to
describe the effects of chemical exposure on neurodevelopment in greater detail.
The practices involved in using qualitative structure-activity relationships (QSARs)
to predict unknown chemical toxicity based on structural homology to known toxins have
been progressing for over a decade (Benigni,1991; Cronin et al., 1995; Worth et al., 2011;
Moudgal et al., 2003; Buick et al., 2015; Garcia-Serna et al., 2015). A chemical’s physical,
chemical, and toxicological properties are derived from its molecular structure and are the
driving forces behind toxin-induced perturbations in enzymatic activity and gene
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expression (Barratt et al., 2000; Cronin et al., 2002; Fussom et al, 1997). Therefore,
structural homology between chemicals can be used to draw conclusions on toxicological
activity. Predictive models for chemical toxicity offer insight where little or no empirical
data is available or feasible. Recently, QSAR models have been used to successfully
predict effects on development related to biologically active chemicals categorized in silico
(Cassano et al., 2010, Alexander et al., 2011; Schwartz et al., 2015; Zhang et al., 2017),
and while the findings of these studies are impressive, the included models address mostly
cytotoxicity and lack coverage of toxic effects on dynamic developmental processes. To
address the general uncertainty around the integrity of machine learning algorithms in real
life applications, it is important to improve and exponentially increase the training sets of
chemical toxicity data predictive models are built on. The work presented in the following
chapters highlights planarian flatworms as a NAM for collecting dynamic
neurodevelopmental toxicity data on a spanning array of environmentally ubiquitous
chemicals.
Chemical risk assessment involves a multitude of factors including the
characterization of hazard, dose-response relationships, and the likelihood and frequency
of human exposure. Efficiently encompassing all aspects of chemical risk requires a battery
of tests; thus, highlighting the utility of high-throughput screening. Planarian flatworms
contribute a suitable non-vertebrate model organism to aid in these endeavors. Their
regenerative prowess and wealth of observable behaviors overpowers concerns over any
evolutionary divergence (Best and Morita, 1982; Hagstrom et al., 2015, 2016; Lowe et al.,
2015). High-throughput implementations of the planarian model for developmental
neurotoxicity enables near continuous observation of photophobic behavior in developing
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planaria. By inducing development at will, via head resection, exposing the headregenerating fragments to exogenous chemicals, and observing photophobic behaviors at
key developmental checkpoints using high-throughput automated measures, the exposureinduced impacts of chemicals on neurodevelopment can be evaluated with high resolution.
Expanded libraries of chemical toxicity data provide the necessary architecture required
for accurate QSAR predictive modeling, and thus are a first step in revolutionizing the way
chemicals are evaluated for safety and risk to human health prior to commercialization.
Harnessing the power of QSAR predictive models in toxicology to evaluate potential
chemical toxicity, alongside chemical design, establishes a framework for “smart”
chemicals that are synthesized with minimized risk to human health considered in
foresight.
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Chapter 3
Materials and Methods
The methodologies used for planarian care and experimentation are common across
most of the work presented herein and are provided in general terms in this chapter.
3.1 Planaria Care and Maintenance
Asexual Schmidtea mediterranea (Smed) CIW4 worms were obtained from the
Sánchez Alvarado laboratory (Stowers Institute, Kansas City, MO). Smed were used for
all studies, except for the behavioral assessment of ethanol toxicity in Chapter 4, where
brown planaria (Dugesia dorotocephala, Carolina Biological Supply Company,
Burlington, NC) were selected to demonstrate similar results across different species of
planaria. All planaria were kept in environments described previously (Cebrià et al., 2002;
Newmark and Alvarado, 2002; Lowe et al., 2015), that includes planaria water (ddH2O
with 1.6 mM NaCl, 1 mM CaCl2, 1 mM MgSO4, 0.1 mM MgCl2, 0.1 mM KCl, and 1.2
mM NaHCO3) kept at 22°C. Planaria were fed calf liver puree weekly and, when not being
fed, cleaned, or observed, were stored in the dark in a Thermo Scientific incubator at 22°C.
Worms 5-10 mm in length were selected for all studies and starved for 7 days prior to
testing based on standard practice (Guedelhoefer and Alvarado, 2012; Sandmann et al.,
2011). For low-throughput, high-throughput, and immunostaining assessments, both
developing and adult/intact planaria were placed in 9 cm petri dishes containing the
assigned testing solution immediately after head resection (developing) or straight from
our starved population (adult/intact) on day 0.
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3.2 Acquisition of Bisphenols
In Chapters 4, 5, and 6, bisphenols are tested for developmental neurotoxicity
potential. It is important to ensure the purity of these materials and thus purity analysis
methods are described in the following section.
Acetonitrile (HPLC grade), methanol (HPLC grade), and glacial acetic acid were
all purchased from VWR. Chloroform-d (CDCl3, 99.8 atom % d) was purchased from
Acros Organics. Bisphenol A (BPA, 97 %, pellets) was purchased from Sigma Aldrich.
The p,p’-bisphenol F (BPF, 98 %) was obtained from Sigma Aldrich. BPA and BPF were
further purified by recrystallization in a 1:1 solution of glacial acetic acid and purified
water (Mauck et al., 2018). Analytical standards for BPA (certified reference material, ≥
99 %) and BPF (≥ 98 % p,p’-isomer) were acquired from Millipore Sigma and used
exclusively for calibration curves. Bisguaiacol (BG) was synthesized and purified to a
mixture of the p,p’-, m,p’-, and o,p’- isomers, as previously reported (Hernandez et al.,
2016). All other chemicals were used as received. Purities of BPA, BPF, and BG were
confirmed by different purity assays.
3.3 Assessment of Bisphenol Purity
Purities of the bisphenols were assessed using ultraviolet high-performance liquid
chromatography (HPLC-UV), differential scanning calorimetry (DSC), and Proton
Nuclear Magnetic Resonance (1H-NMR). Different test methods account for different
types of impurities. The purities of BPA and BPF were determined by HPLC-UV and DSC.
BG did not meet the minimum requirements for reliability, and its purity could not be
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determined by DSC; therefore, it was tested by HPLC-UV and 1H-NMR. Table 3.1
summarizes the purity results.

Table 3.1
Chemical Purity Investigated by Different Assays
by HPLC-UV (%)

by DSC (mol %)

by 1H-NMR

BPA as received

100.4 ± 0.6

99.5 ± 0.1

―

Recrystallized BPA

100.8 ± 3.7

99.5 ± 0.1

―

BPF as received

90.6 ± 2.1

98.1 ± 0.3

―

Recrystallized BPF

95.8 ± 6.9

99.3 ± 0.1

―

Purified BG isomers

95.0 ± 4.1

―

Characteristic*

Test material

Note. *See Hernandez et al., 2016.

BPA, whether recrystallized or not, presented relatively high levels of purity both
by HPLC-UV and DSC, and both samples proved interchangeable. The recrystallization of
BPF improved its purity levels, as confirmed both by HPLC-UV and DSC. BPF samples
were found slightly less pure by HPLC-UV as opposed to DSC. Such observation is likely
an effect of the indirect determination of purity by HPLC-UV assays, which are relative to
an analytical standard and its intrinsic purity. Recrystallized BPA and BPF were deemed
the preferred materials and thus used for testing in this study.
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The BG synthesized and purified in the laboratory was comparable to previous
batches as confirmed by HPLC-UV and 1H-NMR; and its purity was likely affected by
variations in moisture or residual solvent contents between batches. BG also presented a
1H-NMR spectrum consistent with the literature (see Figure 3.1), indicating a
predominance of the p,p’-isomer and traces of the m,p’- and o,p’- isomers (Hernandez et
al., 2016). The relative area underneath the peaks of the 1H-NMR spectrum assigned to
BG isomers was 94.1% of the total area, which agrees with the purity obtained by HPLCUV.
3.3.1 Bisphenol Purity by Ultraviolet High-Performance Liquid Chromatography
(HPLC-UV)
Chromatographic analyses were performed on a Waters Alliance HPLC system
equipped with an automated separations module (Waters e2695) and a photodiode array
detector (Waters 2998). Samples were prepared at three concentrations within the range of
the calibration curve, filtered (0.45 µm), and injected three times each (20 µL per injection).
Purity was calculated as the average ratio between the concentrations found in the samples
and the theoretical concentration.
Samples containing BPA and BPF were eluted through a C18 column (Waters, 75
mm, particle size: 5 µm). A mixture of purified water and acetonitrile (60:40) at a flow rate
of 0.8 mL/min was used as the mobile phase in isocratic conditions (adapted from Rezaee
et al., 2009). Samples containing BG were eluted through a C18 column (Waters, 75 mm,
particle size: 5 µm). A linear gradient with a constant flow rate of 0.8 mL/min was used
for separations, resulting in two adjacent peaks related to BG isomers. Methanol (A) and
purified water containing 0.5% glacial acetic acid (B) were used as elution solvents. The
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gradient started with 10% A: 90% B for 1 min, 50% A: 50% B at 8 min, and finished with
95% A: 5% B at 10 min (adapted from Curia et al., 2018). Linear equations were used to
calculate the concentration of the analytes in the respective samples (Table 3.2).

Table 3.2
Quantification of Test Chemicals by HPLC-UV
Linearity

Test
material

Wavelength
(nm)

Retention
time (min)

slope

yintercept

r2

range
(ppm)

BPA, crm

224

∼3.6

92,500

-12,700

0.99997

1.56 to
62.4

BPF, ≥
98%

224

∼2.3

107,000

-43,000

0.99987

2.04 to
81.6

peak 1:
∼13.2
2.06 to
285
20,456* -47,543* 0.99670*
206.0
peak 2:
∼13.5
Note. BPA – bisphenol A; BPF – p,p’-bisphenol F; BG – bisguaiacol isomers. *A single
Purified
BG

calibration curve was obtained by combining the area of the two peaks.

3.3.2 Bisphenol Purity by Differential Scanning Calorimetry (DSC)
DSC assays were performed using a TA Instruments Discovery DSC 2500
calibrated with sapphire and indium standards. Samples were ground to a homogenous
powder with mortar and pestle. Aliquots (typically 1.00 to 3.00 mg) were weighed into
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hermetic DSC pans and sealed with respective hermetic lids (Tzero, TA Instruments).
Sealed pans were placed on the automated DSC and heated rapidly (10 ℃/min) up to 25
℃ before the theoretical melting point for the pure material. The instrument temperature
was allowed to equalize. Heating continued at 1 ℃/min to completely melt the sample.
After cooling down, pans were reweighed to discard any data that resulted in a mass loss
higher than 1%. Purity was calculated according to the ASTM standard E928-08, method
A (ASTM, 2014). This method relies on the van’t Hoff equation for the measurement of
calorimetric purity, and it is designed to detect any broadening of the melting endotherm
related to nonspecific impurities dissolved in the melt. Reliability is ensured when the
material has more than 98.5 mol % purity, and the incremental enthalpy area correction is
less than 20% (Table 3.3).

Table 3.3
Reliability of Calorimetric Purity Assays
Test material

Mass loss
(%)*

Enthalpy
Correction
(%)**

Enthalpy (J/g)

Tm (℃)

BPA as received

0.17 ± 0.7

11.7 ± 1.7

132.2 ± 7.8

159.0 ± 0.1

Recrystallized
BPA

0.38 ± 0.1

13.2 ± 3.1

125.0 ± 4.6

159.0 ± 0.1

BPF as received

0.26 ± 0.1

9.2 ± 2.0

143.8 ± 2.5

161.9 ± 0.2

Recrystallized
BPF

-0.01 ± 0.5

7.9 ± 1.7

168.4 ± 6.3

164.0 ± 0.1

peak 1: 88.8
peak 2: 98.3
Note. BPA – bisphenol A; BPF – p,p’-bisphenol F; BG – bisguaiacol isomers. *reliable if
Purified BG

n/a

65.9

≤ 1.0%. **reliable if < 20.0%.
30

119.5

3.3.3 Bisphenol Purity by Proton Nuclear Magnetic Resonance (1H-NMR)
NMR analyses were conducted on a Varian 400 MHz spectrometer at 25 ℃ in
CDCl3 at a concentration of about 20 mg/mL. The number of scans was 32, and the
chemical shifts were reported in parts per million (ppm) with respect to residual solvent
peaks (7.26 ppm). The absence of strange peaks was interpreted as qualitative evidence of
purity (Figure 3.1).

Figure 3.1
1

H-NMR Spectrum of Purified Bisguaiacol Isomers
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3.4 Flame Retardant Chemical Library and Purity
In Chapter 7, a panel of 16 chemicals – 8 organophosphate flame retardants, 6
brominated flame retardants, and two negative controls – that were chosen based on their
prominence in the literature and ability to be compared across multiple model organisms
and assays, was evaluated for DNT potential. Zhang et al., 2019 evaluated a near identical
chemical library in Dugesia japonica, a different species of planaria than used in this study.
Our investigation of the chemical panel in Smed provides evidence of concordance
between different planarian species, as well as allows for more direct comparisons of highthroughput screening methods.
3.5 Testing Solution Preparation
1% v/v ethanol solutions were diluted from Absolute Ethanol (Sigma-Aldrich, St.
Louis, MO) in planaria water, as described previously (Lowe et al., 2015).
BPA, BPF, BG, and estradiol (MP Biomedicals, Irvine, CA) testing solutions were
made by dissolving crystals in planaria water to a concentration of 2 ppm and stirred on a
90 ̊C hot plate until complete assimilation of all crystals. Prepared solutions were cooled
to room temperature and stored at 22 ̊C. The 2 ppm concentration was selected as the
highest screening concentration that was uniformly sub-lethal to full, adult planaria across
all chemicals included.
Flame retardant test solutions were diluted from manufacturer stocks in planaria
water to concentrations of 100 µM and 10 µM as previously shown to be of the highest
non-lethal dose in planaria (Zhang et al., 2019).
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3.6 Experimental Design
To induce regeneration, heads were resected with a sterilized scalpel posterior to
the photoreceptors and auricles on day 0 of experimentation. Intact and head-regenerating
tail pieces were exposed continuously to testing solutions or control planarian water for 9
days (n=10 per treatment group, unless otherwise noted). As illustrated in Figure 3.2, the
samples designated for behavioral testing were continuously exposed to their testing
solutions and behavioral testing was conducted on the same worms every 24 hours, for
days 4-9 post amputation (DPA 4-9). As much as possible, operators of the behavioral
testing were blinded to the identity of the test solution groups to eliminate bias. Worms
were checked for survival each day prior to behavioral testing by agitating the petri dish
and watching for signs of movement including scrunching, curling, and stretching out
(Cochet-Escartin et al., 2015). Fatalities were documented and discarded from further
observations. When conducting corroborating immunostaining, separate worms designated
for immunostaining were sacrificed and fixed on each day 4, 5, 6, 7, 8, and 9. Unlike the
planaria utilized for behavioral testing, these worms were pre-determined for exposure
duration and were not tested sequentially.
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Figure 3.2
Workflow Diagram of Experimental Procedure

Note. (A) Test animals were amputated post-auricle and pre-pharynx using a sterilized
scalpel on day 0 of each experiment. (B) Worms selected for behavioral experiments were
kept in their designated test solutions for the entire testing period and cognitive function
was observed using the planarian light avoidance assay every 24 hours, starting 4 days post
amputation. (C) For anatomical experiments, head-regenerating worms were selected from
a population in each designated testing solution for each day of the testing period, starting
on day 4 post amputation. Worms were then killed, fixed, stained, and imaged to assess
CNS structure.

3.7 Immunostaining
Immunostaining was conducted with minor adaptations from previously published
methods from Cebrià et al. (2008) and Pearson et al. (2009). Briefly, at the conclusion of
the exposure period, worms (n=5 per experimental group) were killed in 2% HCl (SigmaAldrich INC., St. Louis, MO) on ice. Carnoy’s solution (Spectrum Chemical MFG Corp.,
34

New Brunswick, NJ) was used to fix the worms, and after subsequent bleaching, samples
were frozen in 100% Methanol (Sigma-Aldrich INC., St. Louis, MO). Smed worms were
rehydrated from storage in 100% methanol solution and blocked in PBSTB (PBS, 0.3%
Triton X-100, and 2.5mg/mL BSA) solution before administration of the primary antibody
anti-SYNORF (3C11, Developmental Studies Hybridoma Bank, 1:50), and secondary
antibody (goat anti-mouse conjugated with Dylight 488 VWR, 1:200). Samples were DNA
counterstained with Hoescht 33342 (1:50) and worms were mounted in Vectashield (VWR,
Radnor, PA). Imaging was done using a Nikon A1 confocal microscope. Images presented
are representative of all images in the treatment group.
3.8 Low-Throughput Behavioral Testing
Mobility testing and light avoidance behavior testing were conducted
simultaneously by combining techniques described in Raffa et al., 2001 and Lowe et al.,
2015. Modifications include using a mini-Maglite LED flashlight (1150 average lux in the
light area and 400 lux in the dark area) and sectioning the 3- x 2- inch testing chamber into
target and non-target areas instead of quadrants. Behavioral testing quantification was done
via the assignment of a cognitive function score (CFS) (Lowe et al., 2015) for each 90second test (equation 3.1).
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(Equation 3.1)

The cognitive function score quantifies light avoidance behavior reacquisition.
Fully developed worms would have a high CFS, representing the cognitive ability to travel
directly to the target area and remain there until the conclusion of the test. For visualization
and comparison, CFSs of experimental groups were normalized to the percent maximum
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of control CFSs for each testing day (Figure 4.3) and normalized to percent maximum of
treatment group CFS’s for each testing day (Figure 4.4).
Low CFSs could be attributed to an inability to move, rather than inadequate
cognitive function to facilitate movement. Lack of movement in planarians was
investigated to further discern the nature of the chemicals’ effects. Stevenson and Beane
showed that exposure to elevated concentrations of ethanol causes the cilia to burn off
(2010). Therefore, immunostaining of ventral cilia using Smed 1H11 antibody (DSHB
University of Iowa, Iowa City, Iowa) was performed on worms in each experiment group
six- and seven-days post head resection to rule out possible deciliation skewing behavioral
results. Normal presence of the ventral cilia (Figure 3.3) indicates that exposed worms are
not deciliated in these conditions.

Figure 3.3
IHC of Ventral Cilia on All Treatment Groups 6- and 7-Days Post
Amputation

Note. Smed 1H11 primary and Dylight 488 conjugated secondary (green). Scale bar is
100µm.
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3.9 Statistical Analysis
Methods for the statistical analysis of CFSs obtained from low-throughput
behavioral experiments, and pPBI scores obtained from HTS, is outlined below.
Data from each experiment was collected into a data frame organized by variables
– treatment group (Group), day post amputation (DPA), and cognitive function
score/planarian photophobic index score (CFS/pPBI) – and processed in the statistical
software R (R Core Team, 2020). One of three ANOVA tests were used to detect any
difference in means of the CFS/pPBI at each level of independent variables (Group and
DPA). For each experiment, a one way, two way, and interaction ANOVA were performed,
and the Akaike information criterion (AIC) test was used to pick the best-fit model. In each
case, the ANOVA model with the lowest AIC score and highest weight was selected. To
confirm the chosen model fits the assumption of homoscedasticity, diagnostic plots, such
as, Residuals vs Fitted, Normal Q-Q, and Scale-Location plots, were analyzed. After
confirming significance within treatment groups, a Tukey’s Honestly Significant
Difference (Tukey’s HSD) post-hoc test was performed on the data for pairwise
comparisons. Treatment group CFSs/pPBIs were considered significantly difference from
one another if the pairwise p value was less than 0.05.
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Chapter 4
Chemical Exposure-Induced Developmental Neurotoxicity in Head-Regenerating
Schmidtea mediterranea

4.1 Introduction
The introductory chapter of this dissertation has outlined the alarming implications
of exposure to under-evaluated chemicals ubiquitous to the environment. Exposure to
known environmental toxins has been linked to neurodevelopmental disorders by altering
neurodevelopmental processes from conception to infancy (Grandjean and Landrigan,
2006, 2014; Paparella et al., 2020). For example, in fetal alcohol syndrome (FAS), ethanol
exposure during pregnancy attenuates fetal development and induces an increased risk of
permanent brain injury (Clarren and Smith, 1978; Jones and Smith, 1973; Streissguth,
1997). Despite reports of chemical exposure-related deficits, even at low levels of exposure
during the heightened sensitivity of development, most commercial chemicals are not
evaluated for safety and risk to human health prior to their inclusion in consumer goods
(Hartung, 2009). Thus, to understand the etiological effects of chemical toxicity, it is
imperative to study exposure-related impacts on neurodevelopment attributed to
environmental chemicals. There is, therefore, a need to study the developmental
neurotoxicity (DNT) potential of chemicals before their incorporation into commercial use
to aid against the reticent emerging threat to human health posed by increasing rates of
chemical production.
Bisphenol A (BPA) is a commonly used plasticizer/monomer, and its exposure and
metabolism data are described in detail in Chapter 2. BPA is among these poorly evaluated
chemicals and is present in many consumer products, including food and beverage
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packaging, epoxy resins, and thermal receipt paper (Vandenberg et al., 2007). BPA is a
known endocrine-disrupting chemical, acting through estrogen receptor competition, and
has been shown to induce developmental abnormalities in both pre-and postnatal studies
(Gray et al., 2004, Vandenberg et al., 2007; Della Seta et al., 2005; Kubo et al., 2004;
Rochester, 2013; Gyimah et al., 2021; Mustieles et al., 2020; Yilmaz et al., 2020). The
favorable performance properties of BPA have encouraged scientists and engineers to
explore alternative chemicals, such as bisphenol F (BPF) and bisguaiacol (BG), that
preserve the advantageous properties of BPA-containing materials with lower toxicity as
potential replacements (Figure 4.1) (Jana et al., 2005; Nicastro et al., 2016). However, these
efforts have primarily been based on in vitro experiments limited to describing cytotoxicity
and estrogenic effects (Pelchet al., 2019; Švajger et al., 2016), which may not be
representative of toxic effects seen in vivo and cannot attest to impacts on the dynamic
process of development. In addition, the nature of DNT assessment is predominantly
retrospective and time-intensive in traditional laboratory animals and higher-level
organisms; therefore, it is imperative to develop means of rapid chemical screening for
DNT potential of known and novel chemicals to complement in vitro studies.
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Figure 4.1
Chemical Structures of BPA, BPF, Estradiol, and BG

Note. BPF and BG have been proposed as BPA alternatives. These molecules retain
desirable mechanical properties in end-use applications, but the effects of their small
structural changes on toxicity have not been evaluated comprehensively.

In this chapter, Schmidtea mediterranea (Smed) planarian flatworms provide an
alternative in vivo screening tool for DNT. The utility of Smed in studying
neurodevelopmental processes and DNT effects is outlined in Chapter 2. Importantly,
planaria possess a centralized nervous system (CNS) that can be regenerated after head
resection in a matter of days (Cebrià, 2007; Cebrià, 2008; Cebrià et al., 2002; Newmark
and Alvarado, 2002; Morgan, 1989; Buttarelli et al., 2008; Hagstron et al., 2015; Inoue et
al., 2015). Planaria also display a distinct light avoidance behavior that can be used to
describe cognitive deficits related to neurodevelopmental abnormalities (Hagstrom et al.,
2015, 2018; Inoue et al., 2015; Li et al., 2014; Lowe et al., 2015; Rawls et al., 2018; Zhang
et al., 2018, 2019). Planarian neurodevelopment has been used to describe DNT effects
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related to chemical exposure in both the behavior and anatomy of head-regenerating
planaria (Inoue et al., 2004; Cebrià et al., 2002, 2007, 2008); however, these studies are
largely disconnected. This chapter presents the first evidence of a correlation between these
two assessment techniques, light avoidance behavior and CNS morphology, in response to
chemical exposure, including ethanol and a subset of bisphenols. Accordingly, inexpensive
and quick behavioral assays provide a suitable surrogate for intensive immunostaining
experimentation, which is comparatively expensive and time-consuming.
4.2 Experimental Design
A full description of experimental methods can be found in Chapter 3; details
specific to this chapter are included below.
Behavioral experiments were performed on 5 and 10 replicates for ethanol and
bisphenol treatment groups, respectively. Ethanol was tested at a concentration of 1 % v/v,
as in Lowe et al., 2015. Bisphenols, BPA, BPF, and BG were tested at a concentration of
2 ppm, determined to be the highest non-lethal dose in Smed. In addition, estradiol was
included as a treatment group at a concentration of 2 ppm to serve as a positive control due
to the reported estrogenicity of bisphenols. The acquisition and purity assessment of these
chemicals is included in Chapter 3.
Planaria were amputated on day 0 of experimentation, and head-regenerating tail
fragments of 5-10 mm in length were immediately placed in their corresponding treatment
group solutions. Flatworms used in behavioral tests were assayed for light avoidance
behavior 4 - 9 days post-amputation (dpa); cognitive function scores (CFSs) were given to
each test animal based on the criteria outlined in Chapter 3 and used to quantify and
compare light avoidance behavior between treatment groups. Flatworms used for
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immunostaining were selected in triplicate from each treatment group on 4 - 9 dpa and
killed, fixed, and fluorescently labeled according to procedures described in Chapter 3.
4.3 Ethanol Induces a Delay in the Reacquisition of Photophobic Behavior that
Correlates to Central Nervous System Regeneration
The effects of ethanol exposure during head-regeneration on light avoidance
behavior reacquisition in Smed have been reported in Lowe et al., 2015. Interestingly,
species-specific exposure-related behavioral irregularities have been described in Ireland
et al., 2020. Here, brown planaria, Dugesia dorotocephala, are used to assess the
consistency of ethanol exposure-related effects on light avoidance behavior due to their
commercial availability and biological diversity. Similar behavioral effects were observed,
specifically the delay in the reacquisition of light avoidance behavior (Figure 4.2 A). The
average CFS of developing planaria exposed to 1% ethanol was significantly lower than
that of the control on days 3 and 4 post-amputation (p < 0.05), with the initial deficit in
light avoidance behavior being recovered after 5 days of regeneration and further (p >
0.05). Comparable delays to cognitive function recovery were also seen in Smed in the
regeneration of CNS morphology in immunostaining experiments (Figure 4.2 B). The
stages of planarian neurodevelopment are defined in Chapter 2 and can be used to compare
CNS structure throughout regeneration between treatment groups. Developed CNS
anatomy, with new spongy brain structure and robust connections through many transverse
commissures, can be observed in the control group after 6 days of regeneration; in the
ethanol-exposed group, this is not observed until 8 dpa. Shifting the data from the ethanolexposed group two days behind the control group further elucidates the correlating
exposure-induced DNT effects seen in behavioral and anatomical assays (Figure 4.2 C and
D). The two-day delay in the reacquisition of light avoidance behavior (Figure 4.2 C) aligns
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temporally with the delay in the recovery of CNS anatomy (Figure 4.2 D), suggesting that
behavioral tests convey evidence of DNT comparable to immunohistochemical analysis. It
is worth noting that the effects of ethanol exposure are only seen in head-regenerating
Smed with intact/fully developed Smed showing no changes to light avoidance behavior
or CNS anatomy (Figure 4.2 E and F), signifying that the mechanisms of these effects are
development-specific.
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Figure 4.2
Ethanol Exposure Related Behavior Can Be Correlated With Cephalic Ganglia Anatomy
After Head-Resection
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Note. (A) Cognitive function score (Lowe et al., 2015) (CFS) of ethanol-exposed worms
shows a delay in photophobic behavior in brown planaria, consistent with previously
reported reacquisition delays in Smed (B) Immunohistochemistry (IHC) of regenerative
period (4 to 9 days) of worms exposed to ethanol compared to control. (C) 48-hour time
offset of CFS data in Panel A shows that ethanol exposure imparts temporal effects on
reacquisition of behavior. (D) 48-hour time offset of Panel B shows that ethanol-induced
delays in behavioral reacquisition mirror delays in anatomical regeneration. (E) IHC of
neurons in non-head regenerating, adult naïve worm. (F) IHC of neurons in non-head
regenerating, adult ethanol-exposed worm. [#] indicates statistical significance (p < 0.05)
between treatment groups. Error bars = SEM. For panels B, D-F, Anti-SYNORF primary
and Dylight (488) conjugated secondary (green) with Hoescht 33342 counterstain (blue).
Scale bar is 100µm.

4.4 Exposure to Bisphenols During Head-Regeneration Attenuates the Reacquisition
of Light Avoidance Behavior and Central Nervous System Morphology Through
Non-Estrogenic Mechanisms
All bisphenols tested impacted neuroregeneration in head-regenerating Smed
(Figure 4.3). Developing Smed exposed to BPA and BG showed similarly severe effects
on light avoidance behavior, while the BPF exposed group showed effects to a lesser extent
(Figure 4.3 A). Immunostaining of the treatment groups showed severe effects on the
recovery of normal CNS anatomy in Smed exposed to BPA, with fewer effects observed
in the morphology of flatworms in the BPF and BG exposed groups (Figure 4.3 B). DNT
effect types can be broadly classified into two non-mutually exclusive categories suppression of neuroregeneration, seen as magnitude differences in BPA and BG treatment
groups, and delay of CNS integrity recovery, seen as temporal differences in BPF, BPA,
and BG treatment groups.
Importantly, small differences in chemical structure amongst bisphenols (illustrated
in Figure 4.1) lead to distinguishable differences in the impact of the chemicals on
neurodevelopment in Smed. The selected bisphenols differ due to small variations in
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conformation or included functional groups but maintain similar core chemical motifs,
namely two phenolics chemically bonded together via a bridging atom or chemical group.
Exposure to BPF induced a delayed temporal effect on neurodevelopment in both
behavioral and morphological assessments with no significant suppression (Figure 4.3).
Conversely, BPA and BG induced both a delayed temporal and a suppressed effect on the
acquisition of light avoidance behavior and proper CNS anatomy (Figure 4.3). Differences
in DNT effects observed in bisphenols suggest that chemical structure plays a mechanistic
role in the etiology of neurodevelopmental toxicity in Smed, and warrants further
classification of proposed BPA alternatives.
The estrogenic effects of bisphenols are described in Chapter 2. Importantly, BPA
has been shown to act as a weak xenoestrogen and disrupt endocrine activity, likely due to
structural homology (see Figure 4.1) between them (Akash et al., 2020; Cano-Nicolau et
al., 2016). Interestingly, although planaria possess robust estrogenic systems (Robb et al.,
2007, 2015); exposure to estradiol affected planarian neuroregeneration in neither the
behavioral nor morphological assays (Figure 4.3), suggesting that bisphenol-related DNT
effects are non-estrogenic.
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Figure 4.3
Bisphenols Attenuate Reacquisition of Photophobic Behavior and Central Nervous System
Morphology in Smed

Note. (A) Cognitive function scores (CFS) of planaria exposed to bisphenols show a range
of impacts on photophobic behavior (Control - gray, Estradiol - blue, BPA - yellow, BPF
- green, and BG - red). All data is scaled to the maximum average control CFS score (day
6) and data points are staggered slightly for visualization purposes. For each chemical n =
10. Error bars represent the standard error of the mean. [*] indicates statistical significance
between BG and control (p<0.05). [^] indicates statistical significance between BPA and
control (p<0.05). [+] indicates statistical significance between BPF and control (p<0.05).
B) IHC of the planarian neuropil and synaptic clefts show stark differences in the anatomy
of worms exposed to bisphenols during head regeneration A condensed regenerative span
of four to seven days shows the crucial period of cephalic ganglia regrowth, when the
lateral branching of neural synapses should occur. Cephalic ganglia region is located in the
anterior region of the worms and is connected ventrally to the animals’ nerve cords. AntiSYNORF primary and Dylight (488) conjugated secondary (green) with Hoescht 33342
counterstain (blue). Scale bar is 100µm.

4.5 Exposure to BPA During Head-Regeneration Induces Severe Effects on
Neuroregeneration
Exposure to BPA during head-regeneration induces delayed and suppressed
neuroregeneration (Figures 4.3 and 4.4). However, the distinction between these effects is
overlooked when only employing endpoint assessments. Looking at the time-shifted and
magnitude-scaled CFSs of BPA exposed flatworms recorded throughout the
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developmental period, the CFS curve aligns with the CFS curve of the control group
(Figure 4.4), suggesting that the underlying processes of neurodevelopment are conserved
across the treatment groups. The complete inability to develop proper CNS structure in
head-regenerating Smed exposed to BPA agrees with the observed deficiencies in light
avoidance behavior, and reports of BPA-related DNT throughout the literature, further
justifying concerns over the chemical’s incorporation in consumer products.
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Figure 4.4
Exposure to 2 ppm BPA Leads to Complex, Drastic Delay, and Suppression of Cognitive
Ability

Note. (A) Time-offset and magnitude-scaled behavioral responses of naïve (black) and
BPA-exposed (yellow) planaria suggest a common trajectory where BPA induces delay
and suppression. Error bars represent the standard error of the mean. (B) IHC images of
BPA 7 to 9 days post amputation shifted to align with Control 4 to 6 days post amputation,
as in Panel A, elucidate complexity beyond delay that likely manifests as suppression in
the behavioral assay. Anti-SYNORF primary and Dylight (488) conjugated secondary
(green) with Hoescht 33342 counterstain (blue). Scale bar is 100µm.
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4.6 Discussion
This chapter presents the first evidence that the reacquisition of behavioral
phenotypes, commonly used to study chemical toxicity (Hagstrom et al., 2015, 2018; Lowe
et al., 2015; Zhang et al., 2018, 2019), during head-regeneration is correlated to the
morphological integrity of CNS structure in developing planaria. This substantiates serial
behavioral assessments as a viable and sensitive approach to discovering and classifying
exposure-induced DNT effects on planarian neuroregeneration.
Planaria exposed to ethanol during head-regeneration displayed a temporal delay
in neuroregeneration that was conserved across behavioral and morphological testing
methods (Figure 4.2). These findings agree with previous work done by Lowe et al., 2015
describing the effects of ethanol on Smed photophobic behavior, as well as in Inoue et al.,
2004 relating the integrity of axonal connections between visual systems and CNS structure
to planarian light avoidance. This indicates that exposure-induced effects on light
avoidance behavior are sufficient to identify DNT potential in ethanol.
Planaria exposed to BPA, and other bisphenols, during head-regeneration induced
DNT effects on neuroregeneration distinct from the effects seen with ethanol exposure.
Moreover, these effects were even differentiable between BPA analogs with strong
structural homology. It has been shown that small structural changes, including different
isomer conformations, between chemicals, can cause different toxic phenotypes (Blagg et
al., 2006; Smith et al., 2009; Peng et al., 2018); our data shows that behavioral assessments
of planarian light avoidance are a sensitive enough metric to elicit and classify these
differences in DNT effects of bisphenols on planarian neurodevelopment. Importantly,
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some effects, especially neurodevelopmental delays, are not observable through endpoint
testing alone, highlighting the significance of serial testing throughout neurodevelopment.
Planarian light avoidance is a sensitive behavioral readout, accessible throughout the entire
regeneration process, indicating that planaria are perfectly positioned to evaluate
intermediate effects of chemical exposure and provide first-line evidence of DNT potential.
This chapter has shown that serial behavioral assessments accurately describe
chemical exposure-induced changes to CNS integrity throughout head-regeneration in
planaria. These results suggest that behavioral observations, which can be conducted
rapidly and cost-efficiently, provide an acceptable surrogate measure of DNT effects to
immunostaining studies, which are time-consuming, tedious, and expensive to produce.
Low-cost high-yield behavioral assays, like planarian light avoidance, can be easily
adapted for use in high-throughput screening platforms and provide an advantageous tool
in advancing the future of chemical screening. Implementation of high-throughput
screening techniques utilizing the planarian light avoidance assay allows for nearcontinuous testing throughout development following chemical exposure, and
experimental design can be augmented to describe dynamic changes to neurodevelopment
attributed to additional variables in chemical exposure, such as dose, duration, and timing.
This influx of chemical toxicity data may contribute to a better understanding of the
etiology of DNT, as well as drive the informed design of safer “smart” industry alternatives
to potentially toxic chemicals.
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Chapter 5
Development and Validation of a High-Throughput Screening Platform for
Assessing Developmental Neurotoxicity in Planaria

5.1 Introduction
Recent government initiatives, such as the Tox21 program (Thomas et al., 2018),
have made alternative animal models for toxicity assessment increasingly popular; Chapter
1 and 2 provide further information on these initiatives. In particular, there is a call for new
chemical screening approach methodologies that will bridge the gap between increasing
rates of chemical production and the current stagnant means of evaluation for safety and
risk to human health. Chapters 2 and 4 highlight planarian flatworms as an in vivo, nonvertebrate, and cost-effective model organism being used to describe DNT potential of
exogenous chemicals. Current methods utilizing planarian flatworms for describing DNT
are not well suited for describing dynamic changes to neurodevelopment due to lowthroughput experiments being generally time-consuming and manually tedious. The
automation of these practices, in similar fashion to high-throughput adaptations of other
model organisms such as zebrafish and C. elegans (Boyd et al., 2010; George et al., 2011;
Partridge et al., 2018; Zhang et al., 2017; Lucanic et al., 2018; Letamendia et al., 2012),
will provide the productivity needed to further characterize exposure-induced effects of
DNT. Two current limitations present in these studies and research utilizing the planarian
light avoidance, in general, are inconsistent methods in one, the presentation of light
stimuli, and two, the observation of animal behavior. Therefore, as a part of this chapter,
we aim to standardize the planarian light avoidance assay using an automated tracking
system to evaluate the extent of planarian light perception.
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The high-throughput adaptation of the planarian light avoidance assay described in
this study builds off previously successful planarian behavioral assays that have
characterized the effects of exposure to alcohol (Lowe et al., 2015), nicotine, cocaine, and
amphetamine exposure and withdrawal (Raffa et al., 2001; Rawls et al., 2006, 2008, 2011),
industrial endocrine disrupting chemicals (Chapter 4; Li et al., 2013a, 2014),
pharmaceutically active chemicals (Li et al., 2013b), flame retardants (Zhang et al., 2019),
and a library of known and suspected neurotoxic substances (Zhang et al., 2018). To
achieve the bandwidth needed to effectively evaluate the dynamics of DNT caused by
exposure to these and similar chemicals, we have created a high-throughput screening
(HTS) platform for the planarian neurodevelopmental toxicity model. Methods for the
automated characterization of planarian behavior have been described in Talbot and
Schöltz 2011. This work extends the premise of automated locomotive phenotype
assessment to characterize photophobic behaviors. Our HTS exploits planaria flatworms’
negative phototaxis, a complex behavior that requires cognitive function to coordinate
movement towards areas of reduced light intensity (Taliaferro et al., 1920; Inoue et al.,
2015), to the gauge cognitive function of planaria throughput periods of neurodevelopment.
By creating an automated and expansive testing environment, where light intensity
gradients are imposed on planaria and their reaction behaviors are analyzed using custom
computer vision software, we can efficiently score relative cognitive ability across
hundreds of test subjects and test conditions at a time. In fabricating this HTS platform for
chemical screening using planarian flatworms, we combine engineering principles and
developmental biology to provide substantial insight on the etiology of chemical DNT.
This chapter serves as a new design assessment that verifies the accuracy of our HTS model
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compared to previously published results, as well as validates new approach methodologies
for automated up-scaled chemical risk evaluations.
5.2 Experimental Design
5.2.1 Influence of Light Directionality on Phototactic Behavior
The impact of the incoming angle of light stimulus in the planarian light avoidance
assay was investigated through performing the assay with varying light directions. The
testing environment consisted of a light area and a dark area, with each test animal starting
in the light area at a fixed distance from the light stimulus. For each angle of incoming
light, testing animals were recorded for 60 seconds, and their movements were tracked
using center of mass (COM) tracking software.
5.2.2 Testing Chamber for Light Directionality Assay
Each light avoidance assay was conducted in a 9 cm diameter petri dish with
aluminum foil covering half of the chamber, bisecting it into a light area (LA) and a dark
area (DA) (Rawls et al., 2001). For directed light at angles of 0°, 45°, and 90°, the
aluminum foil was fixed on one half of the top of the petri dish to make the distinction
between the LA and DA. For incoming angles of 135°, and 180°, the aluminum foil was
fixed on one half of the bottom side of the petri dish to make the bisection. The light was
shone from a ring stand opposite the covered side of the testing chamber, and the light
source (Ozark Trail 9-LED mini-Flashlight, Bentonville, AR) fixed at 22 cm distance from
the testing chamber for each tested angle of incoming light. The distance between the
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camera (iPhone 5s, 8 megapixels, 1080p HD video at 30 fps, Cupertino, CA) and the center
of the testing chamber was fixed at 16 cm.
5.2.3 Behavioral Response Analysis for Light Directionality Assay
For each angle of the incoming light, a single planarian was placed in the center of
the LA and their movements were recorded for a duration of 60 seconds using center of
mass tracking software (D. Brown and A. J. Cox, “Innovative Uses of Video Analysis,”
Phys. Teach. 2009). Replicates of three were performed for each incoming angle of light.
The radial distance from the point of highest intensity of incoming light, measured from a
photometer (Fisherbrand Traceable Dual-Range Light Meter, Fisher Scientific, Waltham,
MA), and the center of mass of the planarian was recorded in one second intervals over the
60-second test. At each second of the test, the location of the planarian was determined to
be either in the LA or the DA using a second origin in the Tracker program. Data for each
worm was normalized by dividing the total distance traveled by the total distance possible
for each setup. An effectiveness score was given to each incoming angle of light by
multiplying the average distance of the three replicates by an effectiveness term, where n
is the number of worms for that incoming angle of the light that reach the DA of the testing
chamber within the duration of the test (Equation 5.1).
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5.2.4 High-Throughput Screening Apparatus
The custom-built screening apparatus can perform 16 simultaneous light avoidance
assays on 160 individual planaria in 90 seconds. Its construction is sectioned into four
identical “pods”, each consisting of an in-house designed and fabricated programmable
LED lightboard with parts purchased from (DigiKey Electronics, Thief River Falls, MN),
mounted wide angle 5-megapixel USB camera (Ailipu Technology Co. Ltd, Guangdong,
China), and four thermoformed high impact polystyrene testing wells (McMaster-Carr,
Robbinsville, NJ). The design was created to optimize four structural components of each
“pod” (enclosure, testing tray, lightboard, and master controller), along with video
processing hardware, packaged in one streamline assembly to advance the throughput of
toxicological screening methodologies. An in-depth documentation of the HTS platform
design is presented in the following results section.
5.2.5 High-Throughput Light Avoidance Assay
The following description of high-throughput testing methods is common across
each experiment utilizing the HTS platform in this chapter as well as Chapters 6 and 7.
Experiments were designed to describe the cognitive ability of planarian flatworms by
scoring their performance on a light avoidance test, where negative phototactic behavior is
compared to locomotive ability. Ten test worms were placed in each testing tray (40
replicates per treatment group), which was then placed into the HTS system and allowed
to acclimate to the dark testing environment for 30 seconds. A “priming” step was
implemented at the start of each test, where the opposite LED light pattern was subjected
on the test worms for 60 seconds to observe their initial ability to perceive light stimuli,
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and to account for random placement between light and dark areas. Immediately following
the priming step, the opposite half of the testing environment was lit up using the HTS
system’s LED lightboard, creating a distinct light area and dark area, and the entire testing
environment was recorded for 90 seconds. This process was started on day 3 post head
resection and repeated for each experimental group through 9 days post head resection.
Videos were processed using the wrMTrck plugin in the image processing program Fiji
(Nussbaum-Krammer et al. 2015). For each frame of each video, worm position was
compared to light intensity at that position to calculate percent time spent in the dark area,
denoted by an 8-bit greyscale pixel value less than 170. Worm velocity was calculated
using track length and the number of tracks present. Planarian photophobic behavioral
index scores (pPBIs) were calculated by quantifying the amount of time each worm spends
in areas of low light intensity and then scaling the result by each worm’s ability to move
(Equation 5.2).
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(Equation 5.2)

5.3 Light Directionality is Important in Phototactic Response Sensitivity in Planaria
Previous, informal experiments have shown that planaria react differently to light
stimuli presented at different orientations. With the growing popularity of planarian
flatworms in toxicity screening, it is important to standardize the methods behind planaria
behavioral testing for high-throughput applications. The planarian light avoidance assay is
a common test being used to assess the effects of exogenous chemicals on CNS integrity
(Byrne et al., 2018; Morris and Bealer et al., 2021; Hagstrom et al., 2015, 2016; Lowe et
al., 2015; Inoue et al., 2004; Raffa et al., 2001; Rawls et al., 2006, 2008, 2011). Defining
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an effective planarian light avoidance assay as the ability to produce repeatable and
appropriate behavioral responses to the given stimulus, here we show that the directionality
of light stimulus is important in creating an effective assay (Figure 5.1). Schmidtea
mediterranea (Smed) were exposed to light presented at five angles relative to the testing
environment orientation (0°, 45°, 90°, 135°, and 180°; Figure 5.1 A). Planaria exposed to
the light stimulus coming from directly above the testing chamber (0°) exhibited the
strongest, most repeatable photophobic response, with each planarian spending most of the
time in the dark area of the testing chamber (Figure 5.1 B). As the angle of light
presentation increases normal to the axial plane of the planaria, the phototactic response to
light stimuli decreases. Planaria exposed to the light stimulus coming from beneath the
testing chamber (180°) exhibited no photophobic response. Using an effectiveness metric
(Equation 5.1), we found that the most effective light avoidance assay had light directed
onto the dorsal side of the test animals, while the least effective assay had light directed
onto the ventral side of the test animals (Figure 5.1 C). These findings are likely directly
related to the anatomy of planarian flatworms; the organs responsible for photoreception
are located on the dorsal side of the planarian body.
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Figure 5.1
Light Directionality Modulates Photophobic Behavior in Smed

Note. (A) Experimental setup. (B) Light avoidance behavior was observed in planaria with
each experimental setup. A positive value (yellow) corresponds to a position in the light
area of the testing chamber and a dark value (black) corresponds to a position in the dark
area. (C) The influence of different angles of incoming light on the negative phototaxis
behavior in planaria flatworms was scored using an effectiveness metric:
2$/#('0& 3)(4&.&1
78'
'(()*+,-).)// /*01) = 3,#(. 2$/#('0& 5,//$6.& ∗ 9 . Distance traveled is recorded at 60
seconds and n is the number of worms per angle that reached the dark side of the testing
chamber. Tests were done in triplicates and observations were recorded at light
presentation angles of 0, 45, 90, 135, and 180 degrees; intermediate points were
interpolated using a custom MATLAB script.

5.4 Design Constraints and Considerations
●
●
●
●
●
●
●
●
●
●

Light stimuli directed from the top
Needs to be high-throughput
Recording worm position alongside light intensity
Housing the worms
Removal of ambient light
Temperature control
Ventilation
Stability
Ease of use/workability
Needs to accurately describe planarian cognitive ability throughout development
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5.5 Design Specifications for High-Throughput Screening Apparatus
5.5.1 Enclosure
The apparatus enclosure can be broken down into four separate subsystems: the
main body, the lightboard tray, the power supply, and the lid. The design and function of
each subsystem are outlined below.
5.5.1.1 Main Body. The main body of the testing enclosure was constructed from
0.06-inch aluminum sheet metal (Joseph Fazzio Inc., Glassboro, NJ) and encapsulates all
electrical components and each testing pod. It consists mainly of a front/bottom panel,
left/back panel, and right/back panel shown below in Figure 5.2.

Figure 5.2
Schematic of Main Body Assembly of HTS Platform

Left/back
panel

Front/bottom
panel
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Right/back
panel

The front of the enclosure features a wide access door to slide the testing tray in
and out, allowing minimal disturbances to the testing animals prior to testing, and easy
access to switching between testing trays to cut down the set-up time in-between tests
(Figure 5.3). The door is cut from 0.6-inch steel sheet metal (Joseph Fazzio Inc., Glassboro,
NJ) and is secured with a 12-in piano hinge and two magnetic latches on the bottom front
corners (McMaster-Carr, Robinsville, NJ).

Figure 5.3
Door Assembly of HTS Platform

Door assembly
(exterior)

Door assembly (interior) with magnetic
latches

5.5.1.2 Ventilation. Ventilation slots along the left and right sides of the enclosure
allow for increased airflow throughout testing. The vents are covered with interior panels
that redirect any incoming light away from the testing tray and keep the interior of the
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apparatus light-tight (Figure 5.4). The vent covers are also designed to support the
lightboard tray at a specific height to effectively focus the light aperture into each testing
pattern.

Figure 5.4
Ventilation Unit Design in HTS Platform

Vent cover
(back)

Vent cover
(front)

Vent cover over right
panel

5.5.1.3 Lightboard Tray. The lightboard tray is a single removable piece crafted
from 0.06-inch aluminum sheet metal (Joseph Fazzio Inc., Glassboro, NJ). It mounts all
four lightboard printed circuit boards (PCBs), their corresponding light apertures, a USB
hub, and the unit’s master controller. It also serves as a barrier between the apparatus’s
electrical components and the testing tray down below. The lightboard tray sits on top of

62

the vent covers at a pre-specified height, with leveling screws threaded through the sheet
metal allowing simple adjustments for aperture focusing (Figure 5.5).

Figure 5.5
Schematic of Lightboard Tray Design

Section view of lightboard tray inside the of the main
enclosure

The tray sits below three different ports mounted on the upper-rear portion of the
main enclosure: the USB port, the vacuum port, and the power port/cable pass-through
port. The dimensions of the lightboard tray were designed to have enough clearance to be
lifted out of the enclosure without interfering with these ports. Small handles on the front
and back sides allow for easy removal.
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5.5.1.4 Power Supply Enclosure. The power supply enclosure is mounted on the
rear of the testing apparatus and patterned with an array of ventilation holes to optimize
heat dispersion. This placement helps minimize heat around the internal PCBs, allows for
easier access to electronics, and keeps the lower testing chamber cool and free from
obstruction. The 0.06-inch aluminum sheet metal housing also mounts to the power switch
and power cable in the back for ease of access and the cable pass through port is located
directly below the lid of the power supply to allow for clean cable management of all eight
connections to the master controller.

Figure 5.6
Schematic of Power Supply Enclosure and Assembly on HTS Platform

Power supply enclosure

Power supply enclosure on full
assembly
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5.5.1.5 Lid. The testing apparatus lid is cut from 0.06 aluminum sheet metal
(Joseph Fazzio Inc., Glassboro, NJ). Its interior dimensions were cut with tolerance to
allow the easy transitions between covered and non-covered while remaining light-tight.
The testing enclosure was assembled mainly with ¼ inch rivets unless otherwise
necessary. After assembly, the interior was painted matte black to eliminate unwanted light
reflection that could possibly skew results.
5.5.1.6 Testing Tray. The testing tray was 3D printed using black polylactic acid
and serves as a placeholder for the disposable testing wells. It holds all four pods together
and creates a barrier to light crossover and video capture between pods. Adjustment screws
were added to the sides of the testing tray to allow perfect alignment after removal/insertion
of new testing trays.

Figure 5.7
Testing Stage Design Model for HTS Platform

Testing tray with frame adjustment screws
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Each pod contained four disposable testing wells to contain the testing solution as
well as up to 20 testing animals. The testing wells were manufactured via a custom
designed mold where sheets of high impact polystyrene are placed atop the mold in a
vacuum thermoforming machine (Figure 5.8). The testing well mold allows for the mass
production of in-expensive disposable wells to eliminate the need for cleaning in between
tests.

Figure 5.8
Thermoforming Mold for Manufacturing Disposable Testing Wells Used in HTS Platform

Testing well mold for thermoforming
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5.5.2 Lightboard
The lightboard refers to the circuits in the apparatus that deliver and control the
light directed at the planaria. The lightboard is broken into four identical pods, where each
pod consists of 32 white LEDs, 32 red LEDs, and a USB 5-megapixel camera (Mouser
Electronics, Mansfield, TX; Ailipu Technology Co. Ltd, Guangdong, China) (Figure 5.9).
Planaria are most responsive to white light and are unresponsive to red light, which allows
the creation of a strong behavioral stimulus with white light, as well as a way to observe
unstimulated behavior in red light (Paskins et al., 2014). Each pod holds 4 testing wells,
each containing 8 LEDs, in which the same pattern test is performed.

Figure 5.9
LED Arrangement of Lightboard on HTS Platform

Diagram of lightboard setup
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The lightboard was designed using the free ECAD software DipTrace, in which the
schematic and layout were compiled and sent to a PCD manufacturing facility. The
lightboard was designed with six layers, to minimize traces running through copper pours
and preserve signal quality. Layer one consists of all components, aside from the white and
red LEDs. Layer two is a signal layer to run traces that could not fit on the top and bottom
layers. Layer three is a power layer, consisting of 15V source, 15V and 5V copper pours.
Layer four is an isolated copper pour for all ground connections. Layer 5 is used exclusively
to power all the white LEDs, and layer six contained all the white and red LEDs (Figure
5.10).
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Figure 5.10
LED Lightboard Design for HTS Platform

Layout of design

Manufactured device
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To control the direction of light, a divider was designed to act as an aperture for
each individual LED and mounted directly on the lightboard (Figure 5.11). The light
controlling device was 3D printed using black PLA with a high fill density. This design
ensures that the light lines up directly with the tray in the specified pattern. It also
eliminates any hot or dark areas of light above the planaria that would occur from the
bleeding of light or crossover between adjacent LEDs.

Figure 5.11
Light Controlling Aperture and Mounted Assembly on HTS Platform

Light controlling device

Aperture mounted on
lightboard

Customization of light patterns and test duration can be achieved through a
graphical user interface (GUI), as well as the ability to save experimental set ups and recall
them for future tests (Figure 5.12).
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Figure 5.12
Concept for Graphical User Interface for HTS Platform

GUI preview

5.5.3 Master Controller
The master controller is the circuit that connects the four pods of the lightboard
together. It serves to distribute power, maintain a steady clock signal to all four pods, and
to manage communications between the pods. For power distribution, the voltage
regulators, a 5-volt regulator (Mouser Electronics, Mansfield, TX) which powers the
master controller, and a 12-volt regulator (Mouser Electronics, Mansfield, TX) which
powers the USB hub.
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Figure 5.13
Master Controller Communication Diagram for HTS Platform
Connectivity

Master controller connectivity

The master controller also has a microprocessor for managing the lightboards of
each pod. This microprocessor (PIC19F19155, Mouser Electronics, Mansfield, TX) sends
a pulse width modulation (PWM) signal to each lightboard through the pod connectors.
This signal sets the duration and pace of the LEDs blinking. The rate of blinking equates
to the brightness of the LED, where a high signal is very bright, and a low signal is dim or
off.
The last primary function is managing communications between the outside world
and the four lightboards. Instructions are transmitted to the enclosure over USB. These
instructions go through an FTDI chip on the master controller to convert them to a signal
of which the microprocessors can interpret. The FTDI chip then sends information to the
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microprocessors on the master controller and the lightboards. Each lightboard interprets
the message and can respond through the master controller into the FTDI chip.

Figure 5.14
Diagram of HTS Platform Circuitry

Diagram of circuitry
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5.5.4 Video Processing and Analysis
Wide angle 5-megapixel USB cameras (Ailipu Technology Co. Ltd, Guangdong,
China) mounted to the center of the lightboard on each pod were used to capture video of
the light avoidance assay. Each video is then processed using a custom javascript
(Nussbaum-Krammer et al. 2015). For each frame of the 90-second video of the light
avoidance assay, each worm’s position and the light intensity at that position is recorded.
This information is then used to assess the cognitive ability of the worms to avoid higher
light intensities. By comparing the percent of time the worms are in areas of higher light
intensity, versus the time spent in areas of lower intensity, we can score the worms
cognitive abilities with respect to other worms’ behavioral performances.
5.6 Verification of HTS Platform
The HTS platform for the planarian light avoidance assay can accurately depict
differences in cognitive performance between naïve and developmental neurotoxin
exposed Smed. Bisphenol A (BPA) is a known neurotoxin and its exposure-induced effects
have been described in Chapter 4 and Li et al., 2014. Using the HTS platform, it was
observed that head-regenerating naïve and BPA-exposed Smed using a 3-point metric to
describe changes in cognitive function across a seven-day regeneration period. The metric,
termed the planarian photophobic behavioral index (pPBI), assesses the ability to perceive
changes in light intensity (Figure 5.15 A), initiative movement towards more desirable
locations (Figure 5.15 B), and make conditioned preferred placement decisions to stay in
areas of lower light intensity (Figure 5.15 C). Smed exposed to BPA during head
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regeneration exhibited significantly lower pPBI scores than naïve flatworms (p < 0.05)
(Figure 5.15 D).

Figure 5.15
Verification of High-Throughput Screening Methods Using the Planarian Light Avoidance
Behavioral Assay to Describe Cognitive Function in Planaria Using a 3-Point Metric

Note. Termed the planaria photophobic behavioral index (pPBI). The experimental group
was exposed to 2 ppm BPA for 9 days following head resection. (A) Displays the number
of worms that failed the priming precursor to the observational testing period each day post
amputation. (B) Displays the movement ability of each experimental group calculated by
comparing the track length to the number of frames tracked. (C) Displays percent time
spent in dark areas of the testing environment of control and experimental groups during
the 90 second observation period. (D) is a combined metric that encompasses data from
each previous test to score the cognitive function of test groups. Error bars represent the
95% confidence interval of the mean.
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5.7 Validation of HTS Platform
Previous studies have shown that low-throughput behavioral assessments of
cognitive function, like the planarian light avoidance assay, accurately describe the
integrity of central nervous system (CNS) morphology in Smed (Chapter 4). It is important
that results from high-throughput methods also agree with planarian CNS morphology.
Here, we compared HTS assessments of naïve and BPA-exposed head-regenerating and
intact adult Smed using the pPBI metric with immunostaining images of Smed CNS on
days 4 through 9 of planarian head regeneration (Figure 5.16). For both experimental
conditions, trends in pPBI scores correlate with CNS morphology in head-regenerating
Smed. Notably, the HTS platform further distinguishes differences between developmental
neurotoxic effects and neurotoxic effects on processes outside of regeneration in planaria,
agreeing with literature describing prominent effects of BPA-exposure on intact adult
Smed.
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Figure 5.16
Validation of HTS Platform Methods

Note. Average CFS of head regenerating Smed compared to average CFS of adult, nonregenerating Smed. (A) Head-regenerating naïve Smed regained normal cognitive function
around 5 days post amputation. (B) Head-regenerating Smed exposed to 2 ppm BPA did
not regain normal cognitive function or display normal photophobic behavior within the 9day testing period. (C) Immunostaining images of naïve and exposed Smed on days 4 - 9
of the regeneration period. Head-regenerating Smed exposed to BPA did not achieve
normal CNS morphology during the 9-day developmental period. Anti-SYNORF primary
and Dylight (488) conjugated secondary (green) with Hoescht 262 33342 counterstain
(blue). Scale bar is 100μm.
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5.8 Discussion
The validated and verified platform outlined in this study provides a method of
automated and high-throughput data collection for chemical developmental neurotoxicity
in planaria. This system is specifically set up to describe dynamic changes, looking at
reacquisition of cognitive function over time. This is complementary to other highthroughput methods that provide baseline assessments of neurotoxicity using a variety of
behaviors in their chemical assessment (Hagstrom et al., 2018; Zhang et al., 2019). Our
model builds off phototaxis assays that use non-directive light to offer an in-depth
evaluation of the photophobic response to directive light.
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Chapter 6
High-Throughput Screening of Chemical Exposure-Induced Developmental
Neurotoxicity in Head-Regenerating Schmidtea mediterranea

6.1 Introduction
In Chapter 4, we showed that light avoidance is a robust behavioral readout that
accurately describes changes to neurodevelopment in head-regenerating planaria. In
Chapter 5, we described the development and verification of our novel high-throughput
screening (HTS) platform used to automate the planarian light avoidance assay. Here, we
utilize the HTS platform to evaluate the DNT potential of bisphenols, previously explored
with low-throughput methods in Chapter 4, to further validate the importance of highthroughput chemical screening methods.
6.2 An Automated Platform for High-Throughput Light Avoidance Assays
An automated platform was developed in Chapter 5 to perform a multitude of
simultaneous planarian light avoidance assays using programmable LEDs and computer
vision software (Figure 6.2). The screening platform contains 16 testing chambers that are
divided into four identical “pods''. Within each pod, an overhead custom-built LED
lightboard projects light patterns onto the testing environments and a USB camera records
the testing environments, enabling up to 16 simultaneous planarian light avoidance assay
experiments. Importantly, the LED lightboard allows customized light modulation to
stimulate photophobic behavior, thereby allowing chemical screening for DNT using the
HTS platform in a fraction of the time. The workflow of using this HTS platform to screen
a chemical for DNT is shown in Figure 6.3.
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Figure 6.2
Schematic of the High-Throughput Screening Platform

Note. (A) Assembly of HTS platform (B) and (C) vertical cross sections (D) outside of
system (E) custom LED lightboard (F) Testing tray (G) Priming step LED pattern (H) Test
LED pattern.
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Figure 6.3
Workflow of Chemical Screen Using HTS Platform

6.3 Multi-Level Analysis of Behavioral Responses to Light Stimuli Improves
Assessment of Cognitive Function in Planaria
Imposing different light pattern stimuli on planaria allows the quantification of each
worm’s ability to sense light differences and the observation of condition preferred
placement decisions. Planaria instinctively avoid light, choosing to occupy areas of lower
light intensity. This innate photophobic response to light is a complex behavior; however,
current high-throughput testing methods have reduced the behavioral assessment to a
binary metric: reflexive reaction, or no reaction, to a light stimulus. Our HTS platform uses
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a 3-point metric, termed the planarian photophobic behavioral index (pPBI), that
encompasses elements to quantify various aspects of light avoidance behavior.
The first element evaluates the number of worms in each testing chamber that fail
to show observable signs of recognizing changes in local light intensity. This binary
priming step accounts for the random starting point of free-swimming worms and identifies
worms that fail to respond to the changing light patterns of the HTS platform (Figures 6.2
G and 6.2 H). Worms that fail priming are recorded to be in the dark area of the testing
environment in the first 3 seconds of the observational period – meaning they were in the
light area of the testing environment at the conclusion of the priming step and thus failed.
Beginning 3 days post amputation, normally developing planaria show a decreasing trend
in the number of flatworms that fail the priming step, and exposure to exogenous chemicals
may affect this trajectory (Figure 6.4 A). The next element of the pPBI score evaluates the
movement ability of planaria. Control flatworms show increasing movement throughout
the regenerative period, and this also may be affected by exposure to exogenous chemicals
(Figure 6.4 B). The final element of the pPBI metric considers the percentage of testing
time spent in areas of low light intensity. This separates worms displaying a preference for
lower light intensities from worms that do not or cannot distinguish between changes in
light intensity (Figure 6.4 C). The combination of these elements, pPBI (Equation 6.2),
provides a more comprehensive evaluation of planarian photophobic behavior, allowing a
more robust elucidation of differences among treatment groups (Figure 6.4 D).
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Figure 6.4
High-Throughput Light Avoidance Behavioral Testing Produces a 3-Point Metric to
Describe Cognitive Function in Planaria

Note. The experimental group was exposed to 1% v/v ethanol for 9 days following head
resection. (A) Shows the number of worms that failed the priming precursor to the
observational testing period each day post amputation. (B) Shows the movement ability of
each experimental group calculated by comparing the track length to the number of frames
tracked. (C) Shows percent time spent in dark areas of the testing environment of control
and experimental groups during the 90 second observation period. (D) is a combined metric
that encompasses data from each previous test to score the cognitive function of test groups.
Error bars represent the 95% confidence interval of the mean.

6.4 High-Throughput Screening Increases Quantity and Quality of Data
The planarian light avoidance assay is used to quantify CNS functionality and can
be employed throughout the process of head regeneration. Photophobic behaviors are not
present in the first few days following head resection and begin to develop three days post
amputation. This corresponds with the development of connectivity between planarian
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photoreceptors and cephalic ganglion, also normally developing 3 days after head resection
and outlined in detail in chapter 2. We have shown previously that exposure may affect the
dynamics of head regeneration without lasting behavioral phenotype (Chapter 4; Lowe et
al., 2015). Our HTS platform for the planarian light avoidance assay enables assessment of
behavioral reacquisition throughout the regeneration period post amputation while
considerably increasing throughput and reducing the error (Figure 6.5 A) and person hours
(Figure 6.5 B). The HTS platform can screen up to 16 experimental conditions
simultaneously with up to 160 test animals (for n=10).

Alternatively, repeated

experimental conditions enable simultaneous assays of up to 160 replicates. Regardless of
the experimental conditions, a full screen of 160 flatworms can be completed in less time
than evaluating 10 animals with low-throughput methods (Figure 6.5 B).

Figure 6.5
High-Throughput Behavioral Testing Accurately Depicts Development of Normal
Cognitive Function in Developing Planaria While Considerably Decreasing Experimental
Error

Note. (A) Average CFS of naïve regenerating Smed tested using low-throughput methods
(dotted) and the HTS platform (dashed). (B) Time required to test n number of animals
using low-throughput methods and the HTS platform. Error bars represent the 95%
confidence interval of the mean.
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6.5 The Novel High-Throughput Screening Platform Produces Results Consistent
With Low-Throughput Methods
Low-throughput light avoidance experiments have been used to describe the effects
of exogenous chemical exposure in head-regenerating Smed (Chapter 4; Lowe et al., 2015).
Results from our HTS platform align with results obtained from low-throughput
experiments testing the effects of exposure to ethanol and bisphenols. These results show
that the HTS platform can describe recoverable developmental delays, as seen with 1% v/v
ethanol exposure (Figure 6.6), and more complex developmental anomalies, such as those
resulting from exposure to low concentrations of bisphenols (Figure 6.7).

Figure 6.6
Exposure to 1% v/v Ethanol During Development Induces a Delay in the Reacquisition of
Normal Cognitive Function in Planaria

Note. (A) Shows the cognitive function of developing planaria exposed to 1% v/v ethanol
for 9 days post amputation. (B) Shows the same experimental group shifted two days
behind the control group to emphasize the delay in cognitive function reacquisition. Error
bars represent the 95% confidence intervals of the mean.
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Figure 6.7
Developmental Deficits in Developing Planaria Exposed to Bisphenols is Seen in Both
Low-Throughput and High-Throughput Light Avoidance Behavioral Assays

Note. (A) Average CFS of naïve and bisphenol-exposed head-regenerating Smed evaluated
using low-throughput methods. (B) Average CFS of naïve and bisphenol-exposed headregenerating Smed evaluated using the HTS platform. Error bars represent the 95%
confidence interval of the mean.

6.6 High-Throughput Screening Provides More Resolution to Differentiate Toxic
Effects
The HTS platform shows more resolution in the effects of different bisphenols on
neurodevelopment in planaria (Figure 6.8 A). We have previously reported in lowthroughput experiments that exposure to the bisphenol analog bisguaiacol (BG) impacts
the cognitive ability of developing planaria to a degree that is inconsistent with the
anatomical development of CNS structure, with behavioral results aligning more closely
with that of BPA exposed flatworms and immunostaining images resembling normal CNS
development. Further investigation of the impacts of BG exposure to regeneration in
planaria using the HTS platform resulted in pPBI scores distinguishable from flatworms
exposed to BPA (Figure 6.8 A), which better agrees with immunostaining results (Figure
6.8 B). The more comprehensive cognitive function metric than previously used CFS,
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combined with the increased productivity of the HTS enables a broader range of
developmental deficits that can be described with behavioral testing.

Figure 6.8
High-Throughput Screening Closer-Aligns With Morphological Assessments of
Neurodevelopmental Effects of Exposure to Bisphenols During Regeneration in
Smed

Note. (A) High-throughput (dotted line) average pPBI score (left axis) compared to lowthroughput (solid line) average cognitive function score (right axis) of developing Smed
exposed to bisphenols, BPA (red), BG (yellow). (B) Immunostaining images of naïve and
chemical-exposed Smed on days 4 - 9 of the regeneration period. Anti-SYNORF primary
and Dylight (488) conjugated secondary (green) with Hoescht 262 33342 counterstain
(blue). Scale bar is 100μm.

6.7 Discussion
In creating an automated, high-throughput chemical screening (HTS) platform for
assessing developmental neurotoxicity in planarian flatworms, we can combine
engineering principles and developmental biology to create substantial insight into the
etiology of chemical toxicity. In addition, the planarian model for neurodevelopment aligns
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with the intentions of government initiatives, including the Tox21 Program, as an
alternative non-mammalian animal system that provides a low-cost, high-yield approach
to screening chemicals for DNT. Planarian flatworms bring the utility of a short
developmental period, wide accessibility, and inexpensive upkeep to high-throughput
chemical screening, and their reactions to chemical exposure have been shown to correlate
with disorders in humans, e.g., Fetal Alcohol Spectrum Disorders and drugs of abuse and
withdrawal (Hagstrom et al., 2015, 2016; Lowe et al., 2015, Rawls et al., 2001; Raffa et
al., 2006, 2008, 20011). Behavioral tests, which are inexpensive and relatively quick and
easy to perform, have been shown to accurately describe deterrents to normal
neurodevelopment in planarian flatworms exposed to neurotoxins (Chapter 4). The
described HTS platform utilized the accessibility of the planarian light avoidance assay to
increase the amount and quality of toxicity data on exogenous chemicals and drastically
reduces the efforts previously needed to assess safety and risk to human health.
Furthermore, recent studies have highlighted a different species of planarian flatworms,
Dugesia japonica, to be the best suited for high-throughput behavioral applications (Ireland
et al., 2020). Thus, there is potentially even higher value to our HTS platform than
described in this study using Smed.
Increasing chemical screening power is the first step in closing the gap between the
minimal amount of chemicals screened for potential toxicity and the thousands of
commercially available chemicals with limited safety data. There is an alarming lack of
knowledge of the effects of chemical exposure on development. Automated HTS serves as
a solution to this problem and a tool for creating the informational architecture needed to
build predictive models for chemical toxicity. It is theorized that chemical structure plays
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a major role in chemical toxicity through modes of biological activity and metabolic
transformations (Barratt et al. 2000). A chemical’s physical, chemical, and toxicological
properties are derived from its unique molecular structure and are responsible for the
molecular interactions that drive changes in enzymatic activity and in turn gene expression
(Barratt et al., 2000; Cronin et al., 2002; Russom et al., 1997). Therefore, a relationship
between chemicals of similar structural characteristics can be drawn to provide insight on
the probability of toxicological effects of pre-synthesized chemicals. Investigating these
qualitative structure-activity relations (QSARs) within the toxicity data obtained from the
high-throughput chemical screening platform presented in this chapter can help establish
predictive models to be used when little or no empirical data on chemical toxicity is
available. Future directives will focus on harnessing these QSARs to evaluate potential
chemical toxicity alongside chemical design, allowing for the implementation of “smart”
chemicals optimized for not only their physical properties, but with safety and risk to
human health considered in foresight.
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Chapter 7
High-Throughput and Predictive Risk Assessments of Common Flame Retardants
in Planaria

7.1 Introduction
Fire damage and loss accounted for 3,390 fatalities, 14,650 fire-related injuries, and
over 10.6 billion dollars in property damage in the US in 2016 (Haynes, 2017). Fortunately,
these staggering numbers are dwindling due to the incorporation of flame retardant
chemicals in the manufacturing of consumer goods and building (structural) materials.
Alongside the advantages of supplementing commercial products with flame retardants
(FRs) has come a sense of concern for introducing additional chemicals into the
environment. Although flame retardants (FRs) have been instrumental in decreasing firerelated injury and loss over the past decade, these chemicals are severely under-classified
for their effects on human development (Costa and Giordano, 2007). The common
household is in near-constant contact with FRs. Traces of brominated (BFRs) and
organophosphate (OPFRs) flame retardants have been found in virtually all indoor
environments around the world including cars, classrooms, living rooms, and offices
(Brommer et al., 2015, Stapleton et al., 2009; He et al., 2018, Percy et al., 2020). BFRs and
OPFRs have also been found in food, air, dust, soil, wastewater, birds, marine species, and
in human tissues, serum, blood, and breast milk (Schecter et al., 2008; He et al., 2015; Kim
et al., 2014; Shoeib et al., 2014; Cequier et al 2015; Obrien et al., 2015; Li et al., 2017).
While heavily-used BFRs are being phased-out due to concerns over their bioaccumulation
and potential toxicity, global production of FRs reached 680,000 tons in 2015 and
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production rates are projected to increase annually despite insufficient evidence of safety
(EPA, 2009; Wei et al., 2015).
These molecules are easily absorbed by the body through inhalation, dust ingestion,
and dermal contact, leading to concerning bioaccumulation rates of these potentially
harmful chemicals (He et al., 2015, Brommer et al., 2015, Percy et al., 2020). Due to the
nature of the routes of exposure to FRs, children are the most at-risk to exposure-induced
toxicity of BFRs and OPFRs, and exposure to harmful chemicals during necessary
processes of development increases the risks of developmental neurotoxicity (DNT) related
to FR exposure (Branchi et al., 2003; Birnbaum and Staskal, 2004; McDonald, 2005;
Herbstman et al., 2010). Importantly, children are susceptible to prolonged exposure to
FRs starting even before birth lasting into childhood. BFRs have been reported to cross the
placenta, with similar concentrations, ranging from 14 – 580 ng/g lipid of BFRs found in
maternal and fetal blood (Mazdai et al., 2003; Bradman et al., 2007). Levels of BFRs found
in breast milk have been increasing in the last decade and are already at alarming levels
(Costa and Giordano, 2007). It has been estimated that breastfed infants are exposed to
approximately 306 ng/kg/day of BFRs, compared to around 1 ng/kg/day for the average
adult (Schecter et al., 2006). Toddlers are also vulnerable to increased FR exposure due to
the high levels of FRs found in dust; it is expected that toddlers ingest approximately 100
mg/day of household dust, compared to 50 mg/day for adults; these differences in body
burden are made even more prominent when compounded with differences in body weight
(USEPA, 1997; Wilford et al., 2005; Costa and Giordano, 2007). An important determinant
of chemical toxicity and bioaccumulation of xenobiotics is their biotransformation and
metabolite production; unfortunately, there is little research on the metabolism of most FRs
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in the human body and is an area in need of further research (Van den Eede et al., 2013;
Roberts et al., 2012).
The ubiquity of FRs increases the urgency and need for in-depth toxicological
assessments of OPFRs. Animal studies have shown that both pre- and postnatal exposures
to BFRs may be related to long-lasting alterations to locomotive and cognitive behavior
(Branchi et al., 2003; Brinbaum and Staskal, 2004; McDonald, 2005; Viberg et al., 2006),
and the unease surrounding their OPFR replacements is furthered by records of DNT linked
to similar classes of organophosphate chemicals, such as organophosphorus pesticides
(Eaton et al., 2008; Gonzalez-Alzaga et al., 2014; Ricceri et al., 2006). In response to the
clear lack of understanding on the effects of OPFRs on human health, scientists have turned
to mass screening using a battery of in vitro and alternative animal assays to investigate
similar toxicological activity between OPFRs and BFRs (Behl et al., 2015). These efforts
have found that exposure to some OPFRs causes comparable toxic effects to what is seen
with BFRs in nematodes and zebrafish when looking at developmental endpoints (Jarema
et al., 2015; Sun et al., 2016; Glazer et al., 2018). Assessing the impact of exposure to these
chemicals alongside development offers additional insight on the severity of OPFR
exposure related DNT.
The previous chapters have shown planarian flatworms to be an advantageous model
for assessing the neurodevelopmental toxicity of exogenous chemicals, and due to their
unique regenerative ability, are an ideal non-vertebrate organism for assessing DNT
throughout development (Chapters 4-6; Hagstrom et al., 2015, 2016, 2018; Lowe et al.,
2015; Zhang et al., 2018). Dugesia japonica, a species of planaria, have been used to screen
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the impact of FR exposure on multiple behavioral assays to assess toxicity over a wide
array of neuronal functions (Zhang et al., 2019). In the study, a 15-chemical library
composed of common OPFRs and BFRs was evaluated for DNT using high-throughput
behavioral assays including locomotion, phototaxis, thermotaxis, and scrunching. The
results of the chemical screen identified that 11 out of 15 FRs were shown to be biologically
active in at least one endpoint, with OPFRs being more potent than BFRs in planarian,
suggesting that some OPFRs may be as toxic as phased-out BFRs. Battery approaches to
chemical screening assays are clearly advantageous and their ability to evaluate multiple
endpoints in parallel enables the collection of multiple lines of first-tier evidence for
chemical toxicity (Alzualde et al., 2018; Hagstrom et al., 2019; Zhang et al., 2018, 2019;
Truong et al., 2020). A major limitation for mass screening efforts is inconsistencies in the
identification of bioactivity across different assays. For example, in Zhang et al., 2019 only
one chemical (EDHP) of the 15 that were screened produced a hit across all assays. The
DNT effects of FRs such as TBB and TCEP have been reported in multiple studies with
conflicting findings (Sun et al., 2016; Dong et al., 2021; Zang et al., 2019; Alzualde et al.,
2018; Bailey et al., 2015). Discrepancies in the reported toxicity of FRs between these
studies suggests that simplification of behavioral assessments could lead to unreported
toxicity and potentially devalue the results obtained from these assays.
In this study, we use Schmidtea mediterranea, another species of planarian flatworm,
to evaluate the effects of common FRs on the reacquisition of photophobic behavior during
development. We have previously shown that innate phototaxis in Smed is a robust
behavioral phenotype that can be assayed throughout head and central nervous system
(CNS) regeneration and is temporally correlated to the anatomical development of CNS
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structure (Chapters 4-6). Planarian light avoidance is an inherently cognitive process that
involves recognizing light stimuli, processing conditioned preferred placement decisions,
and coordinating movement towards more desirable locations; phototaxis assays that
record a binary of reflexive reaction – or no reaction – to nondirective light stimuli
potentially overlook the intricate nuances that add power to behavioral assessments. Our
novel high-throughput screening (HTS) platform offers a comprehensive and rigorous
assessment of planarian light avoidance behavior that is complementary to current
medium- and high-throughput phototaxis assays. The HTS platform utilizes an exhaustive
light avoidance assay that records photophobic behavior in response to changing LED light
patterns, which require complex decision-making and evoke cognitive function on multiple
levels. The performance curve of this assay differentiates between spanning levels of
cognitive ability, and therefore offers resolution beyond baseline bioactivity; such
increased resolution in the analysis of behavioral readouts supports distinction of varying
toxic effects between chemicals of closely related structures. In this chapter, we provide
evidence that analysis of planarian light avoidance is a valuable high-throughput in vivo
assay capable of describing both endpoint and temporal dynamics in DNT and provides indepth records of chemical toxicity, even between chemicals with strong structural
homology.
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7.2 Experimental Design
The methods pertaining to the experiments in this section are described in Chapter
3 and the methods section of Chapter 5. Additional analysis methods unique to this study
are described below.
Planaria were transected immediately posterior to the auricles and allowed to
regenerate a new head, along with new CNS structure, for 9 days post amputation in their
respective testing solutions. The CNS developmental process for naïve worms is described
in detail in Chapter 2. To assess the impact of FRs during development, head-regenerating
Smed were exposed to 14 FRs and 2 negative controls (Table 7.1) immediately following
head-resection, and photophobic behavior was measured every 24-hours starting 3-days
post amputation (dpa) continuing until 9-dpa. Photophobic behavior in developing Smed,
previously shown to be a measure of neurodevelopment, was recorded and analyzed using
a novel high-throughput screening platform and cognitive performance assessment metric,
the planarian photophobic behavioral index (pPBI) introduced in Chapter 5.
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Table 7.1
List of Flame Retardants Evaluated in HTS Screening
Chemical Name
2-Ethylhexyl diphenyl
phosphate
Tris(2chloroisopropyl)phosphate
Tricresyl phosphate
Tris(2-chloroethyl)
phosphate
Triphenyl phosphate
tert-Butylphenyl diphenyl
phosphate
Isodecyl diphenyl
phosphate
Phenol, isopropylated,
phosphate (3:1)
2,2′,4,4′Tetrabromodiphenyl ether
2,2′,4,4′,5Pentabromodiphenyl ether
2,2′,4,4′,5,5′Hexabromodiphenyl ether
2-Ethylhexyl-2,3,4,5tetrabromobenzoate
Bis(2-ethylhexyl) 3,4,5,6tetrabromophthalate
3,3′,5,5′Tetrabromobisphenol A
Acetaminophen (4hydroxyacetanilide)
L-Ascorbic Acid

Abbreviation Classification

Purity

Supplier

EHDP

OPFR

> 90.0%

TCI

TCPP

OPFR

> 99.0%

TCI

TMPP

OPFR

> 99.0%

TCI

TCEP

OPFR

> 93.0%

TCI

TPHP

OPFR

> 99.0%

TCI

BPDP

OPFR

> 98.0%

TRC

IDDP

OPFR

> 98.0%

TRC

IPP

OPFR

> 98.0%

TRC

BDE-47

BFR

> 98.0%

TRC

BDE-99

BFR

> 98.0%

Sigma-Aldrich

BDE-153

BFR

> 98.0%

TRC

TBB

BFR

> 98.0%

TRC

TBPH

BFR

> 95.0%

AmBeed

TBBPA

BFR

> 97.0%

Sigma-Aldrich

A

Negative
Control
Negative
Control

> 99.0%

Sigma-Aldrich

> 99.0%

Sigma-Aldrich

L

Note. OPFR – Organophosphate flame retardants, BFR – brominated flame retardants, TCI
– Tokyo Chemical Industry, TRC – Toronto Research Chemicals.
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7.2.1 pPBI Curve Fitting for Dynamic Variable Calculation
Average pPBI scores collected on each day of the developmental period for each
testing condition were fitted to a sigmoidal curve using the solver function in Excel. Each
data series was fit to a form of the Avrami equation to better understand the dynamic effects
of the test chemicals on planarian neurodevelopment (Equation 7.1). Our previous work
has distinguished the reacquisition of normal cognitive function following head resection
to be of sigmoidal shape, and thus fits to the Avrami equation through the manipulation of
three fitting constants. Vmax is a parameter in the equation representing the steady-state
cognitive performance potential at developmental equilibrium, k is a time delay constant,
and n controls the steepness of the curve. X represents the number of days post amputation
and Y represents average cognitive performance (pPBI scores). Data series were fit to the
Equation 7.1 and the solver function in Excel was used to minimize the sum of squared
residuals between Y and Y_fit.
!

=-$# = >9;? ∗ (1 − !−"# )

Equation 7.1

Time-to-50% of the steady-state cognitive performance potential for each chemical
condition was calculated by solving the Avrami equation for X when Y_fit is equal to half
of Vmax (Equation 7.2).
!
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Equation 7.2

7.3 Organophosphate Flame Retardants Induce DNT With Similar Potency
Compared to Brominated Flame Retardants in Head-Regenerating Planaria
A library of 8 OPFRs (EHDP, TCPP, TMPP, TCEP, TPHP, BPDP, IDDP, IPP), 6
BFRs (BDE-47, BDE-99, BDE-153, TBB, TBPH, TBBPA), and two negative controls
(Acetaminophen, L-ascorbic acid) was evaluated in developing planaria using our novel
high-throughput screening platform for planarian light avoidance behavior. All FR
chemicals were tested in concentrations of 10 and 100 µM, previously determined to be
the most relevant (Zhang et al., 2019); except for TPHP and TBBPA where the 100 µM
conditions were lethal to our Smed, and BDE-99 and BDE-153 due to difficulties in
obtaining higher concentrations. Screens were broken up into three separate rounds;
Control and Control + 0.05% DMSO conditions were evaluated in each round with
consistent results between screens and are therefore only shown once.
Eight of 8 OPFRs produced adverse effects to the reacquisition of photophobic
behavior compared to 5 of 6 BFRs (BDE-47, BDE-99, TBB, TBPH, TBBPA) in at least
one tested concentration, while 5 of 8 OPFRs (TCPP, TMPP, TCEP, TPHP, IPP) and 4 of
6 BFRs (BDE-43, BDE-99, TBB, TBBPA) displayed adverse effects to photophobic
behavior reacquisition at the lower tested concentration of 10 µM (Figures 7.1 and 7.2). Of
the FRs tested, exposure to TCPP, TCEP, and TPHP during head-regeneration induced the
most dramatic effects on neurodevelopment, with Smed exposed to OPFRs displaying
generally lower cognitive ability compared to those exposed to BFRs.
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Figure 7.1
HTS Results of the eEfects of 8 Organophosphate Flame Retardants on Photophobic
Behavior in Head-Regenerating Smed

Note. Planarian photophobic behavioral index (pPBI) scores were measured every 24hours starting on 3-days post amputation (dpa) and ending on 9 dpa. Adverse effects on the
reacquisition of cognitive function were observed in Smed exposed to 8 of 8 OPFRs at at
least one test concentration, 4 of 8 OPFRs displayed developmental neurotoxic effects at
the lowest tested concentration (10 µM). n = 20 for each test condition. Error bars represent
the 95% confidence interval of the mean pPBI score for each day.
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Figure 7.2
HTS Results of the Effects of 6 Brominated Flame Retardants and 2 negative Controls on
Photophobic Behavior in Head-Regenerating Smed

Note. Planarian photophobic behavioral index (pPBI) scores were measured every 24hours starting on 3-days post amputation (dpa) and ending on 9 dpa. Adverse effects on the
reacquisition of cognitive function were observed in Smed exposed to 8 of 8 OPFRs at at
least one test concentration, 3 of 6 OPFRs displayed developmental neurotoxic effects at
the lowest tested concentration (10 µM). n = 20 for each test condition. Error bars represent
the 95% confidence interval of the mean pPBI score for each day.
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7.4 Evaluation of Endpoint and Temporal Effects of DNT on 14 Flame Retardants
To quantitatively analyze these data, the curves shown in Figures 7.1 and 7.2 were
fit to a sigmoidal curve, using the minimization of residual sum of squares (RRS), to
evaluate endpoint and temporal aspects of DNT. Differences in endpoint effects of DNT
were compared by calculating the steady-state cognitive performance potential (Vmax), an
average of pPBI value across the last three days of screening, for each testing condition.
Exposure to all OPFRs and 5 of 6 BFRs (BDE-47, BDE-99, TBB, PBPH, TBBPA)
imposed a suppression of cognitive function in head-regenerating Smed, categorized by a
Vmax less than 20. The average Vmax of control conditions across each screen was 31.84;
a threshold of 20 was selected by considering the average 95% confidence interval among
control conditions. Temporal effects of DNT were assessed through calculating the number
of days post amputation in which 50% of steady-state cognitive performance potential was
achieved (T50). Exposure to all OPFRs and 4 of 6 BFRs (BDE-47, PBPH, TBBPA) induced
a delay in the reacquisition of cognitive function in head-regenerating Smed, categorized
by a T50 greater than 6 dpa. As described in Chapter 2, planaria exhibit normal photophobic
behavior by 6 days of regeneration; after accounting biological variance, a threshold of
reaching half of the Vmax by 6 dpa was chosen to classify developmental delays. Six
OPFRs (EHDP, TCPP, TCEP, TPHP, BPDP, IPP) and 3 BFRs (BDE-47, TBPH, TBBPA)
induced both suppression and delay effects on neurodevelopment in head-regenerating
Smed. Across the entire library of screened chemicals, OPFRs TCPP and TCEP were the
only chemicals to induce suppression and delay effects on neurodevelopment at both
concentrations tested. OPFR TPHP and BFR TBBPA were related to developmental
suppression and delay at the lowest concentration tested; however, they were only tested
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in one concentration. Quantification of endpoint (Vmax) and temporal (T50) effects of
chemical exposure on development enables further classification of DNT (Figure 7.3).
Suppression of neurodevelopment is distinct from neurodevelopmental delays, and the
ability to distinguish between the two notably increases the value of behavioral assays.
Exposure-induced developmental effects of the 14 FRs screened in this study were
categorized by effect type and are presented in Table 7.1. Of the FRs evaluated, three
conditions, EHDP at 10µM, BDE-153 at 10µM, and TBPH at 10µM, experienced no DNT
effects in head-regenerating Smed. It is worth noting, that TBPH, which at 100 µM was
found to cause both neurodevelopmental suppression and delay, was particularly difficult
to fully dissolve into testing solutions. Inaccuracies in the intended and actual
concentrations to attribute to these results. Interestingly, OPFRs induced noticeably more
developmental delays than BFRs. Developmental delays are often more difficult to
describe in toxicity assessments, and consequently often go underreported. The results of
this study add to the mounting evidence that OPFRs could potentially be as
neurodevelopmentally toxic as phased-out BFRs, if not more.
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Figure 7.3
Overview of Dynamic Characterization of Results From HTS of 14 Flame Retardants in
Head-Regenerating Smed

Note. 8 OPFRs, denoted with triangles, 6 BFRs, denoted with crosses, and 2 negative
controls, denoted with filled-in circles. X-axis represents the number of days post
amputation (dpa) taken to regain 50% of steady-state cognitive performance (T50). Y-axis
represents the steady-state cognitive performance (Vmax). Screening results are
categorized into 4 distinct effect groups: Class 1 (blue) – no effect to photophobic behavior
reacquisition (Vmax > 20, T50 < 6), Class 2 (green) – delayed reacquisition of photophobic
behavior (Vmax > 20, T50 > 6), Class 3 (orange) – suppressed reacquisition of photophobic
behavior (Vmax < 20, T50 < 6), and Class 4 (red) – delayed and suppressed reacquisition
of photophobic behavior (Vmax < 20, T50 > 6).
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Table 7.2
Summary of High-Throughput Screening of Common Flame Retardants
Chemical Name

2-Ethylhexyl
diphenyl phosphate
EHDP
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Tris(2chloroisopropyl)ph
osphate
TCPP

Tricresyl phosphate
TMPP

Tris(2-chloroethyl)
phosphate
TCEP

Structure

Category

Conc.
Tested DNT Effect
(µM)

Quadrant
Class

Vmax

T50
(dpa)

100

Delay and
Suppression

4

12.53

6.7

10

No Effect

1

25.14

4.9

100

Delay and
Suppression

4

4.88

9.0a

10

Delay and
Suppression

4

18.58

9.0a

100

Delay

2

26.96

9.0a

10

Suppression

3

15.76

5.9

100

Delay and
Suppression

4

0.00

9.0a

10

Delay and
Suppression

4

12.92

9.0a

OPFR

OPFR

OPFR

OPFR

Chemical Name

Triphenyl
phosphate
TPHP

105

tert-Butylphenyl
diphenyl phosphate
BPDP

Isodecyl diphenyl
phosphate
IDDP
Phenol,
isopropylated,
phosphate (3:1)
IPP

Structure

Category

OPFR

OPFR

Conc.
Tested DNT Effect
(µM)

Quadrant
Class

Vmax

T50
(dpa)

10

Delay and
Suppression

4

1.71

9.0a

100

Delay and
Suppression

4

0.94

9.0a

10

Delay

2

25.05

6.3

100

Suppression

3

9.05

4.7

10

Delay

2

35.57

6.5

100

Delay

2

32.95

6.3

10

Delay and
Suppression

4

18.51

6.9

OPFR

OPFR

Chemical Name

Structure

Category

Conc.
Tested DNT Effect
(µM)

Quadrant
Class

Vmax

T50
(dpa)

100

Delay and
Suppression

4

12.69

6.0

10

Delay

2

23.31

6.7
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2,2′,4,4′Tetrabromodipheny
l ether
BDE-47

BFR

2,2′,4,4′,5Pentabromodipheny
l ether
BDE-99

BFR

10

Suppression

3

19.07

5.6

2,2′,4,4′,5,5′Hexabromodipheny
l ether
BDE-153

BFR

10

No Effect

1

26.84

5.1

Chemical Name

2-Ethylhexyl2,3,4,5tetrabromobenzoate
TBB

Structure

Category

Conc.
Tested DNT Effect
(µM)

Quadrant
Class

Vmax

T50
(dpa)
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100

Suppression

3

5.49

5.2

10

Suppression

3

13.46

5.5

100

Delay and
Suppression

4

19.97

7.6

10

No Effect

1

22.37

5.0

BFR

Bis(2-ethylhexyl)
3,4,5,6tetrabromophthalate
TBPH

BFR

3,3′,5,5′Tetrabromobisphen
ol A
TBBPA

BFR

10

Delay and
Suppression

4

18.79

6.0

Acetaminophen (4hydroxyacetanilide)
A

Negative
Control

10

No Effect

1

32.41

5.8

L-Ascorbic Acid
L

Negative
Control

10

No Effect

1

31.59

5.9

Note. Summary HTS screening of chemical library with chemical name, chemical structure, type (OPFR – organophosphate flame
retardant, BFR – brominated flame retardant), concentration tested, DNT classification, quadrant class (1 – No effect on photophobic
behavior reacquisition, 2 – delayed photophobic behavior reacquisition, 3 – suppressed photophobic behavior reacquisition, 4 – delayed
and suppressed photophobic behavior reacquisition), Vmax (steady-state cognitive performance), T50 (time, in days post amputation
(dpa), taken to reach 50% of the steady-state cognitive performance). a Any chemical with a calculated T50 greater than the length of the
screen (9-dpa) was assigned a T50 of 9.0 for visualization purposes.
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7.5 Discussion
The results of this study comparing the potential developmental neurotoxicity of
phased-out brominated flame retardants and their organophosphorus replacement
chemicals suggest that OPFRs could impact neurodevelopmental processes with equal, or
greater, potency to BFRs. Our findings agree with previous studies in planaria, nematodes,
zebrafish, and in human and rodent cell culture, that most OPFRs exhibit comparable
toxicity to BFRs (Zhang et al., 2019; Alzualde et al., 2018; Behl et al., 2015, 2016: Jarema
et al., 2015; Noyes et al., 2015). Thus, our HTS platform, which evaluates chemical toxicity
throughout neurodevelopment using a robust and exhaustive behavioral readout, presents
a valuable tool in the classification DNT beyond baseline assessments.
Our analysis methods were able to distinguish unique toxicological activity related
to exposure to 16 structurally similar chemicals. It has been shown that chemical structure
plays a major role in chemical toxicity through modes of biological activity and metabolic
transformations (Barratt et al., 2000; Cronin et al., 2002, Buick et al., 2015; Garcia-Serna
et al., 2015). Therefore, structural homology between chemicals can be used to draw
conclusions on the potential toxicity of a chemical when no empirical data is available or
feasible. Predictive models that use qualitative structure-activity relationships (QSARs) to
evaluate unknown chemical toxicity based on structural similarities to known toxins, are a
promising avenue for chemical risk assessment. A very superficial comparison between
the chemical structure of BDE-47, BDE-99, and BDE-153, and HTS data collected in this
study, could draw the conclusion that the number of bromines connected to the diphenyl
ester body effects the severity of exposure induced DNT in Smed. The least toxic BFR,
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BDE-153, has 6 bromine molecules while the most toxic, BDE-47, has only 4, indicating
that size-specific interactions could mediate the impact these chemicals have on
neurodevelopment. Accurate predictive models require an immense amount of data to train
their algorithm. HTS platforms, like the one described in the study, offer a means of
obtaining the informational architecture needed to build the framework of successful
predictive models for chemical toxicity.
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Chapter 8
Conclusions and Future Outlooks
In this dissertation, I have shown that asexual freshwater planaria are a valuable
alternative animal model in the high-throughput screening of developmental neurotoxicity
(DNT). Planarian regeneration is a unique and truly remarkable biological phenomenon
that enables the evaluation of chemical neurotoxicity throughout development in live
animals, serving as one of the only model organisms where this is possible. Furthermore,
planaria are well suited for high-throughput applications due to their short development
time, which can be imposed at will via head-resection, low cost and maintenance, and their
substantial repertoire of quantifiable behaviors that can be directly compared between
developing and adult animals. These biological features allow for meaningful connections
to be made between cellular mechanisms of DNT and functional phenotypes expressed
through animal behavior; further description of these cellular – to – behavioral
relationships are presented in Chapter 4, which provides some of the first evidence of light
avoidance behavior being temporally correlated to the development of central nervous
system morphology following chemical exposure. The development and verification of the
novel high-throughput screening (HTS) platform presented in Chapter 5 offers elucidation
of planaria photosensing ability and its value as a complex cognitive behavioral metric.
This metric can be used to describe a variety of DNT effects, and is exemplified in Chapter
6, which utilizes planarian photophobic to differentiate DNT of structurally similar
bisphenol chemicals. Further evidence for high-throughput, comprehensive, and
exhaustive photophobic behavioral assessments is most strongly presented in Chapter 7,
where our novel HTS platform screened 14 flame retardant chemicals and distinguished
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endpoint and temporal DNT effects in the categorization of four unique effect types.
Alternative animal models that can describe DNT effects beyond the binary of stimulus
reaction/no reaction, and that discern between nuances in complex behavioral phenotypes
provide more powerful accounts of exposure-induced neurodevelopmental toxicity. In this
way, in-depth assessments of DNT can be used to link chemical structure with potential
toxicity. High-throughput chemical screening, utilizing exhaustive behavioral measures,
enables a systematic approach to obtaining the informational architecture required to build
accurate predictive models for developmental neurotoxicity. Taken together, the planarian
model for developmental neurotoxicity serves as a promising first-stage evaluation
technique and offers valuable insight as part of a larger battery of toxicological
assessments. This work provides the framework for easier chemical evaluation that can be
applied at point of fabrication to aid in eliminating the overwhelming backlog of underevaluated chemicals burdened by unmanageable rates of chemical production. Synergistic
efforts between in vitro, alternative animal models, and predictive machine learning
algorithms pave the way to the informed design of “smart” chemicals where safety and risk
to human health are considered in foresight.
The future of toxicological assessment is becoming increasingly dependent on
machines and automation. This work, along with others in the field, will hopefully be an
important stepping stone towards a readily accessible and boundless collection of
information on how the chemicals in our environment affect ourselves and the living things
we care about.
As with all things robotic, the engineers and creatives bringing new ideas to reality
in the area of chemical risk assessment have a responsibility to eliminate bias and be held
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accountable for any misuse or malpractice of their inventions. As we look to the future of
chemical screening, it is important to learn from the misfortunes of the past. Never again
will we experience horrors like those who lived through the Thalidomide tragedy of the
1950’s; however, blind faith in the new frontiers of safety and risk evaluation is as equally
reckless as no regulations at all. This must not be allowed. It is the duty of established and
emerging minds of the field to challenge and enhance progress at every step. With that, it
is my hope that this work is continued and taken further than I could myself.
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Appendix A
Description of Methods and Technical Skills
A.1 Immunohistochemical Investigation of Planarian Central Nervous System
Anatomy
Here, we utilize planarian flatworms as an alternative animal model in the early
screening of potential neurodevelopmental toxins. Planarian flatworms are one of the
simplest organisms possessing a cephalicized nervous system with bilateral symmetry.
Planaria also have a unique regenerative ability stemming from mesenchymal stem cells,
termed neoblasts, that continue to divide into adulthood. Planaria’s high population of
neoblasts enable them to regrow missing portions of their bodies, including their cephalic
ganglia, in a matter of days. We posit that the regeneration of planarian central nervous
system (CNS) anatomy, post head resection, is a useful method to model the processes
involved in human brain development. Throughout this dissertation, we have used an
immunostaining method to assess the effects of neurodevelopmental toxins, such as
Ethanol and BPA, on Schmidtea mediterranea, a species of planaria commonly referred to
as “Smed.” This immunostaining process has enabled us to examine the anatomy of Smed’s
CNS using confocal microscopy. This assay allows us to see differences in the integrity of
CNS during each stage of regeneration between naïve and chemically exposed flatworms.
We hypothesize that gross anatomical differences in CNS anatomy correlates with
observable determinants in behavior and cognitive function.
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A.1.1 Introduction
Planaria flatworms and well-known for their regenerative capabilities. Injuries that
would handicap other organisms are easily remedied by the planarian body. When a
planaria is cut in half laterally, the result is two distinct planaria – one new head stemming
from the original tail fragment and one new tail stemming from the original head fragment.
The remarkable thing is the developmental period for this process is only about one week.
Photoreceptors, sensory neurons, and all other neurons are able to successfully undergo
repair. Previous studies have shown planarian fragments as small as 1/279th of the body
mass of the original flatworm can fully regenerate (Morgan, 1898). This innate ability of
the planaria comes their large populations of pluripotent stem cells termed neoblasts.
Neoblasts are essential in rebuilding the cephalic ganglia after traumatic injury. Besides
the reconstruction of the CNS, neoblasts possess constant recreation of all cell types,
excluding pharyngeal cells, which do not showcase the regenerative prowess of planaria
(Grohme et al., 2018). The anatomy of planaria has made them strong candidates for
regeneration models, and in our case generation models. The short time planaria take to
“regrow” allows for increased accessibility of testing. Immunohistochemistry, a molecular
technique for visualizing morphological structures in vivo, allows for the visual
representation of specific cells in planaria (Pearson et al., 2009); nerve cells are of special
interest for our investigations of the neurodevelopmental impacts of chemical-exposure.
Therefore, the immunostaining method presented here will focus on the CNS morphology
of developing naïve and exposed planaria. There are a wide variety of staining methods
available for Smed due to their fully sequenced genome and ubiquity in non-vertebrate
neurodevelopmental studies. To investigate CNS anatomy in Smed, the presented method
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uses a monoclonal primary antibody, anti-SYNORF1, which is found in mice. A goat antimouse conjugate is the used to fluorescent at a wavelength of 488 nm. The secondary
antibody will fluorescently label the primary antibody and will emit green light at a
detectable level of 516 nm. A Hoescht 33342 fluorescent DNA counterstain serves as
reference. This primary antibody will attach to synapsins, which are a family of proteins
involved in the regulation of neurotransmitters released at synapses, where the fluorescenttagged secondary antibody will attach to the primary antibody-synapsin complex and emit
a light wavelength then to be imaged using a confocal microscope. This assay allows us to
see differences in CNS anatomy throughout development in naïve and exposed worms. It
is used in Chapter 4, Chapter 5, and Chapter 6 in the studies of the impact of bisphenol A
(BPA) and other bisphenols on cognitive function in developing and adult planaria, and in
Chapter 7 in the study assessing the impact of exposure to common flame retardants on
planarian development.
A.1.2 Detailed Methods
Worm Preparation
All Smed worms chosen were at least 0.5 cm long and able moving in their containers prior
to selection. Heads were resected right behind the photoreceptors and before the pharynx.
Immediately after amputation, head-regenerating fragments were placed in 3 cm petri
dishes with 3 mL of respective testing solution. Worms were exposed for times spanning
the developmental process (between 4- and 9-days post amputation).
*The next steps correspond to all worms disregarding the day post-resection.
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1. Remove solutions in 3 cm petri dishes with a pipette and place dish on ice (Ice helps
elongate the worms).
2. Add 3 mL of 2% HCL to the dishes and leave solutions in dishes for 5 minutes.
3. Remove HCL solutions and carefully transfer Smed with a paintbrush to labelled
1.5 mL centrifuge tubes.
4. Add 1 mL of Carnoys solution to fix worms.
5. Nutate the tubes for at least 2 hours in 4° C.
6. Remove Carnoys and add 100% methanol, nutate for 2 minutes to was off excess
fixative.
7. At this point, worms can either be frozen in 100% methanol or bleaching can
commence.
8. If storing leave worms in tubes in -20° C.
9. To bleach add 800 µL of 100% methanol and 200 µL of H2O2 to tubes.
10. Leave worms under direct light overnight.
11. Remove bleach solutions and add 1 mL of 100% methanol.
*At this point, worms can either be stored in -20° C or immunostaining can begin.
Day One: Rehydration and Primary Antibody
1. Remove 100% methanol and add 1 mL of 75 % methanol. Mutate at room
temperature for 10 minutes.
2. Replace 75% methanol and add 1mL of 50% methanol. Nutate at room temperature
for 10 minutes.
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3. Replace 50% methanol and add 1mL of 25% methanol. Nutate at room temperature
for 10 minutes.
4. Replace 25% methanol and wash with 1mL of PBSB for 2 minutes.
5. Remove PBS and add 1 mL of PBSTP (blocking solution). Nutate for 5 hours in
room temperature.
6. Dilute primary antibody (anti-SYNORF1) in PBSTB. Make a 1:50 dilution.
7. Remove PBSTB and add primary antibody dilution, enough to cover the worm.
8. Leave overnight in 4° C with constant nutation.
Day Two: Washes and Secondary Antibody
1. Remove primary antibody and replace with PBSTB. This is a quick wash at room
temperature with nutation for 2 minutes. This will remove excess primary antibody
and reduce oversaturation of confocal images.
2. Remove and replace with fresh PBSTB and let nutate at room temperature for 2
hours. Repeat this step for at least three washes to limit non-specific binding.
All steps following this must be completed in the dark.
3. Dilute the secondary antibody (Dylight488) in PBSTB. Make a 1:200 dilution.
4. Incubate overnight at 4° C with constant nutation.
Day Three: DNA Counterstain
1. Remove the secondary antibody and replace with PBSTB, nutate at room
temperature for 2 minutes.
2. Replace with fresh PBSTB and nutate for 2 hours at room temperature.
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3. Replace with fresh PBSTB and nutate for 2 hours at room temperature.
4. Remove PBSTB and add DNA counterstain with Hoescht 33342. Add 0.5 µg/mL
Hoescht 33342 dissolved in PBS.
5. Nutate for 10 minutes at room temperature.
6. Remove Hoescht solution and nutate 3 times for 10 minutes each with PBS.
7. Remove as much PBS as possible to no liquid is left in the tube.
8. Add one drop of Vectachield or enough to fully cover the worm.
9. Incubate the worm in its tube in Vectashield overnight at 4° C without nutation.
Day Four: Mounting and Imaging
1. Carefully transfer the worm with a paintbrush to a microscope slide. Make sure
there is extra Vectashield on the slide to preserve the worm.
2. Use clear nail polish and put four drops on the edges of the coverslip and press
down over the worm.
3. The secondary antibody is Dylight488. This is excited at 493 nm and emits at 518
nm.
A.1.3 Acknowledgements
This protocol was skillfully put together by Liz Bealer, a former undergraduate researcher
of the Systems Biology and Neurodevelopment Laboratory.
A.1.4 Figures
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Figure A.1
Immunostaining of Central Nervous System Structure in Adult Brown Planaria

Note. Anti-SYNORF primary and Dylight (488) conjugated secondary (green). Scale bar
is 200µm.

Figure A.2
Immunostaining of Central Nervous System Structure in Adult Smed

Note. Anti-SYNORF primary and Dylight (488) conjugated secondary (green)) with
Hoescht 33342 counterstain (blue; left) Propidium Iodide counterstain (red; right). Scale
bar is 100µm.
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A.2 High-throughput Screening User Notes
Methods for operating our novel high-throughput screening (HTS) platform
utilized in Chapters 5-7 are outlined in this section. To begin using the HTS platform to
obtain planarian photophobic behavioral index (pPBI) scores, first attach the power cord
to a wall outlet, the USB connection cable to a computer, and flip on the power switch
located on the rear of the machine. Next on the computer, open one Putty window for
each testing pod and the camera app of choice. On each putty window, set the desired
testing light pattern and testing time. Next, load the test animals into each testing well
with their respective testing solutions. Let the animals acclimate to the machine in the
dark for one minute. Then, for each pod, run the priming step on the Putty window for a
duration of 60 seconds. During this time, ensure that the camera app is focused on the
active testing well. As soon as the 60 seconds is up, use the Putty window to switch from
the priming light pattern to the desired test light pattern. Immediately press record on the
camera app and allow the test to run for 90 seconds before ending the recording. Save the
resulting video to perform post hoc video analysis described in the next section. Once
each testing condition has been recorded, turn off the machine and place the test animals
back into their respective containers in the incubator. Repeat this process on days 3 – 9
post amputation for developmental experiments.
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A.3 Post hoc Video Analysis Checklist
Complete the following steps in Fiji in order:
§

Import Video File: File -> Import -> Movie(FFMPEG) -> Select Video ->

Uncheck ‘Use virtual stack’ -> click ‘OK’
§

Convert Video to 8-bit: Image -> Type -> 8-bit

§

Obtain background Image: Image -> Stacks -> Z Project -> Keep Start/Stop slice

the same ‘Projection type’ = Max Intensity -> click ‘OK’
§

Subtract Background Image from Video: Process -> Image Calculator -> Image 1

= original video, Operation = ‘Difference’, Image 2 = Background Image
§

Threshold Result Video: Image -> Adjust -> Threshold -> Select ‘Max Entropy’

‘B&W’ check ‘Dark Background’ and ‘Don’t reset range’ use arrows to set top scroll bar
to value that displays every test animal while minimizing background noise click ‘Apply’
-> Uncheck ‘Calc threshold for each image’ click ‘OK’
§

Run wrMTrck: Plugins -> wrmtrck -> wrmtrck -> enter these values:
o minSize = 50
o maxSize = 1300
o maxVelocity = 200
o maxAreaChange = 100
o minTrackLength – 150
o benThreshold = 2.0
o binSize = 0.0
o rawData = 1
o bendDetect = 0
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o FPS = 15
o threshMode = ‘Otsu’
§

Save Raw Tracks File: Click Raw Tracks Window - > File -> Save As - > Name

Video ‘Condition Day’ example: ‘Ctrl 4 dpa’ or ‘BPA 6 dpa’
§

Save Summary File: Click Results Window -> File -> Save As -> Name Video

‘Condition Day Summary’ example: ‘Ctrl 4 dpa Summary’ or ‘BPA 4 dpa Summary
§

Save Reference File: On the last video of a certain condition save Background

Image -> Click Background Image -> Save As -> ‘Text Image’ -> Name Video
‘Condition Reference’ example: ‘Ctrl Reference’ or ‘BPA Reference’
Complete the following steps in R studio in order:
§

Open ‘Analysis_Function.R’ File: File -> Open File -> Data Drive -> R Code ->

‘Analysis Function.R’
§

Run Anlaysis_Function Code: Select ‘Analysis_Function.R’ tab move cursor to

line 2 ‘Analyze<-function(x,y){‘ and press Ctrl + Enter on keyboard
§

Open ‘Video Tracking Analysis.R’ File: File -> Open File -> Data Drive -> R

Code -> ‘Video Tracking Analysis.R’
§

Import Tracking Data: change X<-read.csv(“D:HTS Videos/Folder Name/File

Name.csv”) to reflect the file to be analyzed
§

Import Reference Picture File: change Y<-read.delim(“D:HTS Videos/Folder

Name/Reference for Condition File Name.txt”, header=FALSE) to reflect the condition
being analyzed
§

Import Summary File: change S<-read.csv(“D:HTS Videos/Folder Name/ File

Name Summary.csv”) to reflect the Summary File to be analyzed
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§

Run Analysis Function: Move cursor to line 7 ‘Analyze(X,Y) and press Ctrl +

Enter on the keyboard
§

Display Histogram of Light Intensities for each test animal: Press Ctrl + Enter on

keyboard for lines 11-23
§

Display Average Histogram of Light Intensities: Press Ctrl + Enter on Keyboard

for lines 25-29
§

Display Bar Graph of Time spent in Dark for each test animal: Press Ctrl + Enter

on keyboard for lines 33-40
§

Display pPBI score for each test animal: Press Ctrl + Enter on keyboard for lines

43-51
§

Display Average pPBI score for Video File and 95% CI: Press Ctrl + Enter on

keyboard for lines 53-57
§

Copy and paste pPBI results into Data Collection File: Copy and paste each value

for ‘Upper’ ‘Mean’ ‘Lower’ into the corresponding Excel cells for Video File
Repeat steps for each Video File to be Analyzed
The following section displays the R code for Post hoc Video analysis used to obtain
pPBI scores in Chapters 5, 6, and 7.
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A.4 HTS Data Analysis R Code
# Read in Tracking Data from Fiji
X <- read.csv("~/R/R Code/Flame Retardants/Ctrl 8 dpa.csv")
# Read in Reference image data
Y <- read.delim("~/R/R Code/Flame Retardants/Ctrl Reference.txt", heade
r=FALSE)
# Read in Summary Data from Fiji
S<- read.csv("~/R/R Code/Flame Retardants/Ctrl 8 dpa Summary.csv")
Analyze<- function(x,y){
# Import raw tracks data from wrmtrck and reference image data
# x is RawTracks
# y is PixVals
# Remove Flag columns from Raw Tracks for each Worm identified
df<-x[,c(TRUE, TRUE, FALSE)]
# Creates an empty matrix to hold light intensity values
TempLight = matrix(nrow = nrow(df), ncol=ncol(df)/2)
SC = 1
# For each column in df/2 if == 0 TempLight = NA, else TempLight == P
ixVal
for (i in 1:(ncol(df)/2))
{
for (j in 1:length(df[,(2*i-1)]))
{
if (df[j,2*i-1] == 0)
{
TempLight[j,i] = NA
}
else
{
ycoord = df[j, 2*i-1] * SC
xcoord = df[j, 2*i] *SC
TempLight[j,i] = y[xcoord, ycoord]
}
}
}
temp <- (ncol(df)+ncol(TempLight))
# Adds TempLight Intensity to columns of df
Tracks = matrix(nrow = nrow(df), ncol=temp)
for (i in 1:(ncol(df)/2))
{
Tracks[,(3*i-2)] <- df[,(2*i-1)]
Tracks[,(3*i-1)] <- df[,(2*i)]
Tracks[,(3*i)]<-TempLight[,i]
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}
# Adds Column names to Tracks df
colnames.now <- vector(length=ncol(Tracks)/3)
for (i in 1:((ncol(Tracks))/3))
{
colnames.now[3*i-2] <- paste('X', i, sep="")
colnames.now[3*i-1] <- paste('Y', i, sep="")
colnames.now[3*i] <- paste('I', i, sep="")
}
colnames(Tracks)<-colnames.now
Tracks <- as.data.frame(Tracks, row.names = NULL, optional = FALSE)
# Creates global variables for COM Tracks and Light Intensity
Results<<-Tracks
Intensity<<-TempLight
#View(Results)
}
Analyze(X,Y)
# Histogram of individual worm light intensities
## Red line is dark to light threshold (170)
## Blue line is average light intensity
## Yellow line is light intensity at starting point
#dev.off()
par(mar=c(2,2,2,2))
par(mfrow=c(round(sqrt(ncol(Intensity))),round(sqrt(ncol(Intensity)))))
for (i in 1:ncol(Intensity)){
hist(Intensity[,i], xlim=c(min(Intensity[which(!is.na(Intensity))])
,max(Intensity[which(!is.na(Intensity))])
),xlab = "Light Intensity", ylab = "Frequency", main = paste('Worm',
i, sep=""))
abline(v=170, col="red")
avg<-mean(Intensity[,i], na.rm=TRUE)
abline(v=avg, col="blue")
abline(v=Intensity[1,i], col="yellow")
}
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# Average histogram of all worms
## Red line is dark to light threshold (170)
## Blue line is average light intensity
#dev.off()
hist(Intensity, xlab = "Light Intensity", main = "Control 8 dpa")
avg<-mean(Intensity, na.rm=TRUE)
abline(v=avg, col ="blue")
abline(v=170, col="red")

# Bar Graph of time spent in the dark (<170) for each worm
Dark = 170
TID = matrix(nrow=1,ncol=ncol(Intensity))
for (i in 1:ncol(Intensity)){
TID[,i]<-(sum(Intensity[,i]<Dark, na.rm =TRUE)/sum(complete.cases(Int
ensity[,i])))*100
TID[is.na(TID)]<-0
}
#dev.off()
barplot(TID, xlab="Worm Index", ylab="Percent Time", main = "Time Spent
in Dark Area")

148

# Calculates pPBI Score for each worm
CFS<- matrix(nrow= 1, ncol = ncol(TID))
Intensity[is.na(Intensity)] = 200
for (i in 1:ncol(TID)){
if (mean(Intensity[1:30,i], na.rm=TRUE) > Dark){
# Passed Priming
CFS[,i]<-(TID[,i]) *(S[i,]$Length/S[i,]$X.Frames)
} else {
# Failed Priming
CFS[,i]<-0
}
}
# Removes outliers
CFS_in<-CFS[!CFS %in% boxplot.stats(CFS)$out]
CFS_in<-as.matrix(CFS_in)
#View(CFS)
WormIndex<-c(1:nrow(CFS_in))
plot(x = WormIndex, y = CFS_in)
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avgCFS<- mean(CFS_in, na.rm = TRUE)
sdCFS<-sd(CFS)
# Calculates 95% CI of the mean
library(Rmisc)
library(GLDEX)
CI((fun.zero.omit(CFS_in)*(length(fun.zero.omit(CFS_in)))/length(CFS_in
)), ci = 0.95)
##
upper
mean
lower
## 38.93213 29.53483 20.13754
# Percent of worms that failed priming step
(length(CFS_in)-length(fun.zero.omit(CFS_in)))/length(CFS_in)
## [1] 0.3793103
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A.5 pPBI Curve Fitting and Dynamic Variable Calculation
In Chapter 7, the average pPBI scores collected on each day of the developmental
period for each testing condition were fitted to a sigmoidal curve using the solver function
in Excel. Each data series was fit to a form of the Avrami equation to better understand
the dynamic effects of the test chemicals on planarian neurodevelopment (Equation A.1).
The Avrami equation models how solids transform from on phase of matter to another
under constant temperature and is commonly used to describe the kinetics of
crystallization. The Avrami equation shares similar properties with the Michaelis-Menten
equation for enzyme kinetics and it has been used to outside the realm of phase changes to
model chemical reaction rates; it has even been used to analyze the dynamics of ecosystems
(Avramov et al., 2007). In Chapter 7, we use the Avrami equation to model the dynamic
changes in cognitive ability during development in planaria. Our previous work we has
distinguished the reacquisition of normal cognitive function following head resection to be
of sigmoidal shape, and thus fits to the Avrami equation through the manipulation of three
fitting constants. Vmax is a factoring constant in the equation representing the steady-state
cognitive performance at developmental equilibrium, k is a time delay constant, and n
controls the steepness of the curve. In our equation, X represents the number of days post
amputation and Y represents average cognitive performance (pPBI scores). Data series
were fit the Equation A.1 and the solver function in Excel was used to minimize the sum
squared residual between Y and Y_fit (Figure A.3).
!
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Equation A.1

Figure A.3
Curve Fitting Data Series to Avrami Equation Using the Solver Function in Excel to
Minimize the Residual Sum of Squares Between Actual and Fit Values

In the Michaelis-Menten equation, the time it takes to reach 50% of the max rate of
the reaction (Vmax) provides valuable information on the dynamics of substrate-enzyme
interactions. Therefore, we posit that the time it takes to reach 50% of steady-state
cognitive ability (T50) during development can be used to identify developmental delays
related to chemical exposure. Time-to-50% of the steady-state cognitive performance for
each chemical condition was calculated by solving the Avrami equation for X when Y_fit
is equal to half of Vmax (Equation A.2).
!
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Equation A.2

Comparing variables that govern the dynamics of development, such as Vmax and
T50 is Equations A.1 and A.2, increases the power of the HTS platform presented in
Chapters 5, 6, and 7. The analysis methods described add value to the data obtained from
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high-throughput screening and are essential to creating predictive toxicity models for
planarian light avoidance behavior.

153

Appendix B
Route of Chemical Exposure Effects Toxicity Phenotype in Schmidtea mediterranea
B.1 Introduction
Planarian flatworms are a commonly used in vivo alternative animal model for
studying the exposure-induced developmental neurotoxicity of chemicals throughout
development. Planaria poses simple anatomy with relatively complex central nervous
system structure, including a bilobed brain-like cephalic ganglia with bilateral symmetry.
The planarian body is composed of large populations of pluripotent stem cells that allow
them to be master regenerators, with the ability to regrow entire animals, including their
central nervous system, from missing portions of their bodies in a matter of days. The
planarian model for neurodevelopment uses head-regeneration, which can be imposed on
the worms through head-resection, as a surrogate of human brain development. Combined
with low-cost and maintenance needs, planaria are an ideal model for evaluating the effects
of chemical exposure on neurodevelopment. However, there is a major limitation to this
model organism. At the moment, only water-soluble chemicals can be delivered to the
flatworms; this drastically lowers the impact of the planarian model for developmental
neurotoxicity.
Planaria can be exposed to chemicals through two methods. Dermal absorption
through diffusive properties is the current standard for introducing chemicals of interest.
The second method, presented in the paper, is through feeding. Planaria eat using a
pharyngeal opening protruded from their anterior plane or “bellys”. Planarians require a
protein-rich diet, such as pureed calf liver and hard-boiled eggs, to maintain sufficient body
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density; therefore, we know that nutrients from food are able to cross the pharyngeal
barrier. There has also been success getting double-stranded RNA molecules, delivered
through feeding, past the planarian digestive system to reach their molecular targets
(Rouhana et al., 2013). Contrary to these findings, there is no evidence that organic
chemicals are able to be fed to planaria and maintain normal bioactivity. Informal
experiments conducted in our lab have confirmed that feeding planaria known toxins,
namely bisphenol A, at concentrations magnitudes higher than lethal concentrations when
administered through aqueous diffusion, causes no adverse effects in the planaria. These
findings call for more formal evaluations of the selectivity of the planarian gut, as
elucidating the mechanisms involved in this phenomenon could prove useful in multiple
aspects of planarian research.
B.2 Materials and Methods
Planaria Care and Maintenance
This study was conducted using Schmidtea mediterranea (Smed) planaria obtained
from the Sanchez Alvarado laboratory. Planaria were housed in artificial pond water
consisting of 1x Instant Ocean (IO, Blacksburg, VA) at a temperature of 22 C. Smed
o

planaria are fed pureed calf liver weekly, and were cleaned in fresh water twice a week,
once on the day of feeding and once two days following. Mature visibly healthy planaria
(3-5 mm) were selected from a large colony. All flatworms chosen were starved for one
week upon selection.
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Solution Preparation and Delivery Methods
Solutions of bisphenol A (BPA) used for BPA diffusion studies were made by
dissolving BPA crystals in a sample of artificial pond water at varying concentrations.
Concentrations of 2 ppm, 4 ppm, and 8 ppm BPA were used in this study. Chemically
infused food used for the BPA ingestion model was created by blending powderized BPA
crystals with pureed calf liver until homogenous to make final concentrations ranging from
2 ppm BPA to 50,000 ppm BPA. Eight different food dyes were selected for both the
ingestion and absorption food dye assays. Red, blue, pink, yellow, orange, green, magenta,
teal, and purple colored food dyes were used. The solution used for food dye absorption
studies consisted of three drops of food dye mixed with 125 ml of artificial pond
water. Food for the food dye ingestion model was produced by mixing a sample of three
drops of food dye with 1 gram of pureed calf liver. An initial stock solution of 5,000 ppm
dextran was created using 10 mg of 2,000,000 Da tetramethylrhodamine dextran, obtained
from ThermoFisher Scientific, dissolved in 2 mL of DI water. The solution used for the
dextran diffusion model was made using 50 μL of dextran stock solution diluted with 125
ml of planarian water to create a final concentration of 2 ppm dextran solution. Food for
the dextran ingestion model was produced by mixing a sample of 150 mL of dextran stock
solution, a drop of red food dye, and 1 gram of pureed calf liver to produce a final
concentration of 2 ppm dextran infused food.
The inclusion of a drop of red food dye in both the BPA and dextran studies acts as
a confirmatory factor that planaria ate the chemically infused food. Because dextran and
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BPA are colorless, it could be undetermined whether or not they actually ate the food. The
addition of the red food dye allows for visual confirmation.

BPA Diffusion
Bisphenol A (BPA) was routinely screened for toxicity in Smed planaria by
following methods described in Morris and Bealer et al., 2021. Ten flatworms into petri
dishes containing varying concentrations of BPA solutions. Planaria were then observed
over the course of one week for any visible health defects or lethality.

BPA Supplemented Feeding
Planaria were starved for one week, placed into different petri dishes, and fed
various concentrations of BPA infused liver. Planaria were allowed to eat for
approximately one hour in a dark environment and observed over the course of one week
for any visible health defects or lethality.
Diffusion of Food Dye Experimental Procedure
To mimic previously conducted toxicity screenings such as the BPA diffusion
model, a more general assay for visualization of the diffusion of chemicals via the
surrounding environment was developed using various colored food dyes. In this assay ten
mature planaria were exposed to dye infused solution via the water in which they are
housed. Planaria were kept in this environment for 24 hours before alternating to fresh
water at the start of each day for five days. Flatworms were imaged daily to observe any
food dye remaining within the planaria.
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Food Dye Supplemented Feeding
Following the ingestion model introduced for the BPA ingestion studies, a more
general assay for visualizing digestive pathways was developed using various colored food
dye. Planaria chosen for the ingestion assay were starved for approximately one week.
Ingestion studies consisted of ten flatworms housed in a petri dish of artificial pond water.
A sample of the food mixture infused with food dye was introduced to the dish. Flatworms
were imaged daily to observe any food dye remaining within the planaria.
Dextran Supplemented Feeding
Similar to the food dye studies, this study consisted of ten mature planaria
immersed in a petri dish of 2 ppm dextran solution in a dark environment for approximately
one hour. The worms were left in the dextran infused water for an hour before being
immediately rinsed and fixed. Planaria were imaged immediately after.
Ingestion of Dextran Experimental Procedures
Planaria chosen for the ingestion assay of dextran were starved for approximately
one week. Ingestion studies consisted of ten flatworms housed in a petri dish of artificial
pond water. A sample of the food mixture infused with dextran and red food dye was
introduced to the dish.
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Fixation and Analysis Techniques
After each trial of either diffusion or ingestion of dextran, planaria were rinsed with
artificial pond water and killed by immersing them in a 100 mM solution of sodium azide
solution for approximately 20 minutes. Flatworms were then placed on glass slides and
allowed to settle. Slides were viewed under the fluorescence microscope. NIS-Elements
AR software was used to interpret images produced by exciting dextran molecules with
the 555-580 nm wavelength. Observations were made on the dispersion of dextran
molecules anatomically throughout Smed worms.
B.3 Results

Figure B.1
Planaria Before Feeding (Left) and Planaria After Feeding With Calf Liver Pureed With
BPA Crystals (Estimated Concentration of 50,000 ppm) and Red Food Dye (Right)

Note. Photos take 24 hours prior to feeding and 24 hours after feeding respectively. No
observable effects are seen in the planaria fed BPA, while worms exposed to concentrations
greater than 4 ppm BPA are lethal within 24 hours.
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Figure B.2
Different Routes of Exposure Cause Different Distributions of Chemicals in Planaria

Note. Planaria exposed to a dextran fluorescent molecule (red) through dermal absorption
resulted in unspecific localization (left), while planaria exposed to the same dextran
molecule (red) through feeding resulted in specific localization to planarian digestive
anatomy. These results suggest that the planarian digestive system possess a selective
barrier to certain molecules. It is unclear whether this selectivity is size-based or involves
other mechanisms of action. Scale bar is 100 µm.
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Appendix C
The Complex Control System of Planarian Regeneration – If Worms Can Do It,
Why Can’t Humans?
Introduction
The rest of this dissertation has considered planarian regeneration as an established
process; here, we briefly consider the incredible control system responsible for this feat.
Living organisms are endowed with the ability to regulate their internal conditions
through various levels of control. These levels involve the orchestrated interplay between
Chemical, Cellular, Tissue, Organ, Systems, and Organismal components. In practice,
different organisms have different aptitudes for such control. The planarian flatworm, for
example, can regrow full organisms, with a complete central nervous system, from pieces
1/279th the size of its original body (Morgan, 1898). Mammals, however, have very limited
regeneration prowess. Although some mammalian tissues, such as skin, blood, and gut
epithelia, can be restored to their original state following injury, most tissues can never be
completely revived (Schroeder, 2008). There are several injuries that are categorized by
degenerations and these injuries could greatly benefit from remedies specifically designed
with the information gained from studying the control systems aspects of regeneration in
simpler organisms. To shed light on why some tissues regenerate and others do not, here
we take a closer look at the underlying control system principles that govern regeneration
in the model organism Schmidtea mediterranea.
Often recognized as “immortal under the edge of a knife,” planaria are bilateral
flatworms with remarkable regenerative capabilities, including the ability to regenerate
161

their entire central nervous system upon head resection (Pallas, 1766; Dalyell, 1814; Child,
1911; Morita, 1966). Attributing to the astonishing feat of replacing tissue lost to age and
damage, the planarian body is composed of a large population of pluripotent stem cells,
termed neoblasts (~30% of cells) (Baguna, 1989). These neoblasts, positioned across the
entire body, excluding the most anterior tip and pharynx, produce linage-committed cells
that further differentiate into epithelium, neurons, muscles cells, and other specialized
tissue (Morita, 1966; Baguna, 1989; Wolff and Dubois, 1948; Newmark and Alvarado,
2000). The sheer number of undifferentiated cells may explain some of the planarian’s
aptitude for regeneration, being that irradiated animals regenerate proportionally less than
control animals, based on the percent of body irradiated (Wolff and Dubois, 1948).
Upon injury, the cellular events of neoblast migration and differentiation produce
the regeneration blastema. What exactly is to be regenerated in the regeneration blastema
is challenging to describe. Concepts of polarity began in 1904 with T. H. Morgan stating
“something in the piece itself determines that a head shall develop at the anterior cut surface
and a tail at the posterior cut surface. This ‘something’ is what we call polarity” (Morgan,
1904). More than a century later, we can further describe this “something” as concentration
gradients of morphogens, including expression of position control genes and bioelectric
patterns (Cervera et al., 2020; Pietak et al., 2019). Cell-cell transport of positional
information was originally introduced in Turning, 1952, which conceptually demonstrated
reaction-diffusion mechanisms for positional control through the diffusion of chemical
agents, termed morphogens, across cell membranes (Turning, 1952). Recent investigations
have brought to light the influence of bioelectrical signaling on body plan patterning
control and regulation (Beane et al., 2013, 2011). All living cells maintain a difference in
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electrical potential energy between the plasma membrane of itself and that of contiguous
cells (Wright, 2004). The propagation of this membrane voltage potential (Vm) across
tissue is an efficient means of cellular communication and by results a driving force of cell
decisions and behaviors (Whited and Levin, 2019). In planarian flatworms, there exists
localized regions of depolarization and hyperpolarization of membrane potential present in
an anterior-to-posterior gradient along the animal (Beane et al., 2011; Durant et al., 2017).
It is believed that changes in this Vm gradient, induced by injury, can be sensed, and in
part elicit the regeneration wound-response in planaria. Membrane voltage potential’s part
in the wound response may take advantage of its functionality as a regulator with access to
biostability, or switching between states of depolarization and hyperpolarization, to
activate downstream pathways of gene expression (Cervera et al., 2016). The planarian
body can be thought of as a network of gap junction-coupled somatic cells with different
Vm levels, where the information that travels from cell to cell is modulated and directed
through gap junctions (Oviedo et al., 2010). A cascade control system where fast
bioelectrical signaling is a slave to diffusion-reaction signaling and gene expression could
describe a control system for planarian regeneration.
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